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1. INTRODUCTION

The RCM3400 is a compact module that incorporates the pow-
erful Rabbit® 3000 microprocessor, flash memory, static RAM,
digital 1/0 ports, analog inputs, and PWM outputs.

The Development Kit has the essentials that you need to design
your own microprocessor-based system, and includes a com-
plete Dynamic C software development system. This Develop-
ment Kit also contains a Prototyping Board that will allow you
to evaluate the RCM3400 and to prototype circuits that interface
to the RCM3400 module. You will also be able to write and test
software for the RCM3400 modules, including Ethernet or
TCP/IP applications.

Throughout this manual, the term RCM3400 refers to the complete series of RCM3400
RabbitCore modules unless other production models are referred to specifically.

The RCM3400 has a Rabbit 3000 microprocessor operating at up to 29.4 MHz, static
RAM, flash memory, an 8-channel A/D converter, two clocks (main oscillator and time-
keeping), and the circuitry necessary for reset and management of battery backup of the
Rabbit 3000’s internal real-time clock and the static RAM. Two 34-pin headers bring out
the Rabbit 3000 1/0 bus lines, parallel ports, A/D converter channels, and serial ports.

The RCM3400 receives its +3.3 V power from the customer-supplied motherboard on
which it is mounted. The RCM3400 can interface with all kinds of CMOS-compatible
digital devices through the motherboard.

1.1 RCM3400 Features

e Small size: 1.16" x 1.37" x 0.31"
(29 mm x 34 mm x 8 mm)

e Microprocessor: Rabbit 3000 running at up to 29.4 MHz
e 47 parallel 5V tolerant I/O lines: 41 configurable for 1/0, 3 fixed inputs, 3 fixed outputs
e Two additional digital inputs, one additional digital output

e Combinations of up to eight single-ended or four differential analog inputs
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One additional analog input (CONVERT)
External reset input

Alternate 1/0 bus can be configured for 8 data lines and 6 address lines (shared with
parallel 1/0 lines), 1/O read/write

Ten 8-bit timers (six cascadable) and one 10-bit timer with two match registers

512K flash memory, 512K SRAM, (options for 256K flash memory and 256K SRAM)
Real-time clock

Watchdog supervisor

Provision for customer-supplied backup battery via connections on header J2

10-bit free-running PWM counter and four width registers

Two-channel Input Capture can be used to time input signals from various port pins

Two-channel Quadrature Decoder accepts inputs from external incremental encoder
modules

Five CMOS-compatible serial ports: maximum asynchronous baud rate of 5.5 Mbps.
Four ports are configurable as a clocked serial port (SPI), and two ports are config-
urable as SDLC/HDLC serial ports.

Supports 1.15 Mbps IrDA transceiver

There are two RCM3400 production models. Table 1 summarizes their main features.

Table 1. RCM3400 Features

Feature RCM3400 RCM3410
Microprocessor Rabbit 3000 at 29.4 MHz
Flash Memory 512K 256K
SRAM 512K 256K
A/D Converter 12 bits

5 shared high-speed, CMOS-compatible ports:
5 are configurable as asynchronous serial ports;
Serial Ports 4 are configurable as clocked serial ports (SPI);
2 are configurable as SDLC/HDLC serial ports;
1 asynchronous serial port is used during programming

The RCM3400 can be programmed through connections on the motherboard supporting
RS-232, USB with an RS-232/USB converter, or over an Ethernet.

Appendix A provides detailed specifications for the RCM3400.
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1.2 Advantages of the RCM3400

Fast time to market using a fully engineered, “ready-to-run/ready-to-program’ micro-
processor core.

Competitive pricing when compared with the alternative of purchasing and assembling
individual components.

Easy C-language program development and debugging

Rabbit Field Utility to download compiled Dynamic C .bin files, and cloning board
options for rapid production loading of programs.

Generous memory size allows large programs with tens of thousands of lines of code,
and substantial data storage.

Reference design allows integrated Ethernet port for network connectivity, with
royalty-free TCP/IP software.
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1.3 Development and Evaluation Tools
1.3.1 RCM3400 Development Kit

The RCM3400 Development Kit contains the hardware essentials you will need to use
your RCM3400 module. The items in the Development Kit and their use are as follows.

RCM3400 module.
Prototyping Board.

AC adapter, 12 V DC, 1 A. (Included only with Development Kits sold for the North
American market. A header plug leading to bare leads is provided to allow overseas
users to connect their own power supply with a DC output of 8-24 V at 8 W.)

10-pin header to DB9 programming cable with integrated level-matching circuitry.

Dynamic C CD-ROM, with complete product documentation on disk.

Getting Started instructions.

A bag of accessory parts for use on the Prototyping Board.

Rabbit 3000 Processor Easy Reference poster.

Registration card.

DIAG

Cable

RO

RabbitCore RCM3400

Getting Started
Instructions

Programming

AC Adapter
(North American
kits only)

0 S

Accessory Parts for
Prototyping Board

Prototyping Board

Figure 1. RCM3400 Development Kit
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1.3.2 Software

The RCM3400 is programmed using version 7.32 or later of Dynamic C. A compatible
version is included on the Development Kit CD-ROM.

Rabbit Semiconductor also offers add-on Dynamic C modules containing the popular
uC/OS-11 real-time operating system, as well as PPP, Advanced Encryption Standard
(AES), and other select libraries. In addition to the Web-based technical support included
at no extra charge, a one-year telephone-based technical support module is also available
for purchase. Visit our Web site at www.rabbit.com or contact your Rabbit Semiconductor
sales representative or authorized distributor for further information.

1.3.3 Connectivity Interface Kits

Rabbit Semiconductor has available additional interface Kits to allow you to provide a
wireless interface to the RCM3400 and to use the RCM3400 with header sockets that have
a 0.1" pitch.

e 802.11b Wi-Fi Add-On Kit (Part No. 101-0998)—The Wi-Fi Add-On Kit for the
RCM3400 footprint consists of an RCM3400 Interposer Board, a Wi-Fi CompactFlash
card with a CompactFlash Wi-Fi Board, a ribbon interconnecting cable, and the soft-
ware drivers and sample programs to help you enable your RCM3400 module with
Wi-Fi capabilities. The RCM3400 Interposer Board is placed between the RCM3400
module and the RCM3400 Prototyping Board so that the CompactFlash Wi-Fi Board,
which holds the Wi-Fi CompactFlash card, can be connected to the RCM3400-based
system via the ribbon cable provided.

e Connector Adapter Board (Part No. 151-0114)—allows you to plug the RCM3400
whose headers have a 1.27 mm pitch into header sockets with a 0.1" pitch.

Visit our Web site at www.rabbit.com or contact your Rabbit Semiconductor sales repre-
sentative or authorized distributor for further information.

1.3.4 Online Documentation

The online documentation is installed along with Dynamic C, and an icon for the docu-
mentation menu is placed on the workstation’s desktop. Double-click this icon to reach the
menu. If the icon is missing, use your browser to find and load default.htm in the docs
folder, found in the Dynamic C installation folder.

The latest versions of all documents are always available for free, unregistered download
from our Web sites as well.
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2. GETTING STARTED

This chapter describes the RCM3400 hardware in more detail, and
explains how to set up and use the accompanying Prototyping Board.

NOTE: This chapter (and this manual) assume that you have the RCM3400 Development
Kit. If you purchased an RCM3400 module by itself, you will have to adapt the infor-
mation in this chapter and elsewhere to your test and development setup.

2.1 Install Dynamic C

To develop and debug programs for the RCM3400 (and for all other Rabbit Semiconductor
hardware), you must install and use Dynamic C.

If you have not yet installed Dynamic C version 7.32 (or a later version), do so now by
inserting the Dynamic C CD from the RCM3400 Development Kit in your PC’s CD-ROM
drive. If autorun is enabled, the CD installation will begin automatically.

If autorun is disabled or the installation does not start, use the Windows Start | Run menu
or Windows Disk Explorer to launch setup . exe from the root folder of the CD-ROM.

The installation program will guide you through the installation process. Most steps of the
process are self-explanatory.

Dynamic C uses a COM (serial) port to communicate with the target development system.
The installation allows you to choose the COM port that will be used. The default selec-
tion is COML. You may select any available port for Dynamic C’s use. If you are not cer-
tain which port is available, select COM1. This selection can be changed later within
Dynamic C.

NOTE: The installation utility does not check the selected COM port in any way. Speci-
fying a port in use by another device (mouse, modem, etc.) may lead to a message such
as "could not open serial port" when Dynamic C is started.

Once your installation is complete, you will have up to three new icons on your PC desk-
top. One icon is for Dynamic C, one opens the documentation menu, and the third is for
the Rabbit Field Utility, a tool used to download precompiled software to a target system.

If you have purchased any of the optional Dynamic C modules, install them after installing
Dynamic C. The modules may be installed in any order. You must install the modules in
the same directory where Dynamic C was installed.
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2.2 Hardware Connections
2.2.1 Attach Module to Prototyping Board

Turn the RCM3400 module so that the Rabbit 3000 chip is facing up and the Rabbit logo is
facing the direction shown in Figure 2 below. Align the pins from headers J1 and J2 on the
bottom side of the module into header sockets RCM1JA and RCM1JB on the Prototyping
Board. The shaded corner notch at the top left corner of the RCM3400 module should face the
same direction as the corresponding notch below it on the Prototyping Board.

RCM3400
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0O000Q000000 000 £ g i
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o 00000000000000000000000000
1 0O000000000000000000000000]
Q000Q0Q00Q0Q0QQ0Q0Q0QQQQ0)
i 010, 01076.010.010.6 010, 0]0.¢;0]0.010}0.0.0.0]0,0.¢

YOOOC

press down
here.

Figure 2. Install the RCM3400 Module on the Prototyping Board

NOTE: Itisimportant that you line up the pins on headers J1 and J2 of the RCM3400
module exactly with the corresponding pins of header sockets RCM1JA and RCM1JB
on the Prototyping Board. The header pins may become bent or damaged if the pin
alignment is offset, and the module will not work. Permanent electrical damage to the
module may also result if a misaligned module is powered up.

Press the module’s pins firmly into the Prototyping Board header sockets—press down in the
area above the header pins using your thumbs or fingers over the connectors as shown in
Figure 2. Do not press down on the middle of the RCM3400 module to avoid flexing the mod-
ule, which could damage the module or the components on the module.

Should you need to remove the RCM3400 module, grasp it with your fingers along the top and
bottom by the connectors and gently work the module up to pull the pins away from the sock-
ets where they are installed. Do not remove the module by grasping it at the sides.
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2.2.2 Connect Programming Cable

The programming cable connects the RCM3400 to the PC running Dynamic C to download
programs and to monitor the RCM3400 module during debugging.

Connect the 10-pin connector of the programming cable labeled PROG to header J2 on the
RCM3400 Prototyping Board as shown in Figure 3. Be sure to orient the marked (usually red)
edge of the cable towards pin 1 of the connector. (Do not use the DIAG connector, which is
used for a normal serial connection.)

To
PC COM port

p

shr?( wra

Programming
| Cable

Blue

Colored

v

3-pin
power connector

210.070201016.0101020160.0102026 0]

JUUUUUUUUUUUUUUUUU R
00000000000 ‘

DOOOOOOOOOOOOOOOOOOOOOL 0000000000000

3000OOOOOOOOOO0OOOOOOOOOOOOOOOOOOOOOOOOC
0000000000000000000000000000000000000000)
B300008030000030000008 8888888888888
0000000000000000000 & : & nnnnmnnnnnr

xxxxxxxxxxxxxx
o

00000

0000000 0000000000000
00000000000000000000000000)
oo 00000000000000000000000000R)
1 00000000000 000000000000000)
00000000000 00000Q000000QQO

i |

Figure 3. Connect Programming Cable and Power Supply

NOTE: Be sure to use the programming cable (part number 101-0542) supplied with this
Development Kit—the programming cable has blue shrink wrap around the RS-232
converter section located in the middle of the cable. Programming cables with clear or
red shrink wrap from other Rabbit Semiconductor kits are not designed to work with
RCM3400 modules.

Connect the other end of the programming cable to a COM port on your PC.

NOTE: Some PCs now come equipped only with a USB port. It may be possible to use
an RS-232/USB converter (Part No. 540-0070) with the programming cable supplied
with the RCM3400 Development Kit. Note that not all RS-232/USB converters work
with Dynamic C.
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2.2.3 Connect Power

When all other connections have been made, you can connect power to the Prototyping Board.
Connect the wall transformer to jack J8 on the Prototyping Board as shown in Figure 3.

Plug in the wall transformer. The power LED on the Prototyping Board should light up. The
RCM3400 and the Prototyping Board are now ready to be used.

NOTE: A RESET button is provided on the Prototyping Board to allow a hardware reset
without disconnecting power.

2.2.3.1 Overseas Development Kits

Development kits sold outside North America include a header connector that may be con-
nected to 3-pin header J9 on the Prototyping Board. The connector may be attached either way
as long as it is not offset to one side. The red and black wires from the connector can then be
connected to the positive and negative connections on your power supply. The power supply
should deliver 8 V=24 VV DC at 8 W.
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2.3 Run a Sample Program

If you already have Dynamic C installed, you are now ready to test your programming
connections by running a sample program. Start Dynamic C by double-clicking on the
Dynamic C icon or by double-clicking on derab XXXX.exe in the Dynamic C root
directory, where XXXX are version-specific characters. Dynamic C uses the serial port
specified during installation.

If you are using a USB port to connect your computer to the RCM3400 module, choose
Options > Project Options and select “Use USB to Serial Converter” under the
Communications tab.

Find the file poNG. ¢, which is in the Dynamic C sampLES folder. To run the program,
open it with the File menu, compile it using the Compile menu, and then run it by selecting
Run in the Run menu. The STDIO window will open on your PC and will display a small
square bouncing around in a box.

2.3.1 Troubleshooting

If you receive the message No Rabbit Processor Detected, the programming
cable may be connected to the wrong COM port, a connection may be faulty, or the target
system may not be powered up. First, check to see that the power LED on the Prototyping
Board is lit and that the jumper across pins 5-6 of header JP10 on the Prototyping Board is
installed. If the LED is lit, check both ends of the programming cable to ensure that it is
firmly plugged into the PC and the programming port on the Prototyping Board. Ensure
that the module is firmly and correctly installed in its connectors on the Prototyping
Board.

If Dynamic C appears to compile the BIOS successfully, but you then receive a communi-
cation error message when you compile and load a sample program, it is possible that your
PC cannot handle the higher program-loading baud rate. Try changing the maximum
download rate to a slower baud rate as follows.

e Locate the Serial Options dialog in the Dynamic C Options > Project Options >
Communications menu. Select a slower Max download baud rate.

If a program compiles and loads, but then loses target communication before you can
begin debugging, it is possible that your PC cannot handle the default debugging baud
rate. Try lowering the debugging baud rate as follows.

e Locate the Serial Options dialog in the Dynamic C Options > Project Options >
Communications menu. Choose a lower debug baud rate.

If there are no faults with the hardware, select a different COM port within Dynamic C.
From the Options menu, select Project Options, then select Communications. Select
another COM port from the list, then click OK. Press <Ctrl-Y> to force Dynamic C to
recompile the BIOS. If Dynamic C still reports it is unable to locate the target system, repeat
the above steps until you locate the active COM port.You should receive a message Bios
compiled successfully once this step is completed successfully.
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2.4 Where Do | Go From Here?

If the sample program ran fine, you are now ready to go on to the sample programs in the
RCM3400 User’s Manual (click the documentation icon on your PC) and to develop your
own applications. The sample programs can be easily modified for your own use. The user's
manual also provides complete hardware reference information and software function calls for
the RCM3400, the Prototyping Board, the Ethernet reference design, and the optional
LCD/Keypad module.

For advanced development topics, refer to the Dynamic C User’s Manual and the
Dynamic C TCP/IP User’s Manual, also in the online documentation set.

2.4.1 Technical Support

NOTE: If you purchased your RCM3400 through a distributor or through a Rabbit Semi-
conductor partner, contact the distributor or partner first for technical support.

If there are any problems at this point:
e Use the Dynamic C Help menu to get further assistance with Dynamic C.

e Check the Rabbit Semiconductor Technical Bulletin Board at
www.rabbit.com/support/bb/.

e Use the Technical Support e-mail form at www.rabbit.com/support/.
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3. RUNNING SAMPLE PROGRAMS

To develop and debug programs for the RCM3400 (and for all
other Rabbit Semiconductor hardware), you must install and use
Dynamic C. This chapter provides a tour of its major features
with respect to the RCM3400.

3.1 Introduction

To help familiarize you with the RCM3400 modules, Dynamic C includes several sample
programs. Loading, executing and studying these programs will give you a solid hands-on
overview of the RCM3400°’s capabilities, as well as a quick start with Dynamic C as an
application development tool.

NOTE: The sample programs assume that you have at least an elementary grasp of ANSI
C. If you do not, see the introductory pages of the Dynamic C User’s Manual for a sug-
gested reading list.

In order to run the sample programs discussed in this chapter and elsewhere in this manual,

1. Your RCM3400 must be plugged in to the Prototyping Board as described in Chapter 2,
“Getting Started.”

2. Dynamic C must be installed and running on your PC.

3. The programming cable must connect the programming header on the Prototyping
Board to your PC.

4. Power must be applied to the RCM3400 through the Prototyping Board.

Refer to Chapter 2, “Getting Started,” if you need further information on these steps.

To run a sample program, open it with the File menu (if it is not still open), compile it
using the Compile menu (or press F5), and then run it by selecting Run in the Run menu
(or press F9). The RCM3400 must be in Program Mode (see Figure 7) and must be con-
nected to a PC using the programming cable.

More complete information on Dynamic C is provided in the Dynamic C User’s Manual.

User’s Manual 13



3.2 Sample Programs

Of the many sample programs included with Dynamic C, several are specific to the
RCM3400. These programs will be found in the saMPLES\RcM3400 folder.

Each sample program has comments that describe the purpose and function of the pro-

gram. Follow the instructions at the beginning of the sample program.

e CONTROLLED.c—Demonstrates use of the digital inputs by having you turn LEDs
DS1 and DS2 on the Prototyping Board on or off from the STDIO window on your PC.

Parallel Port D bit 6 = LED DS1
Parallel Port D bit 7 = LED DS2

Once you compile and run CONTROLLED. ¢, the following display will appear in the

Dynamic C STDIO window.

I
B, Stdio [_ (O]

<< Proto-hoard LED's e

From PC kevboard:

Zelect 1=D31 or 2=D3Z to toggle LEDs=

< Press 'Q' To Quit =

Al

-

M

Press “1” or “2” on your keyboard to select LED DS1 or DS2 on the Prototyping
Board. Then follow the prompt in the Dynamic C STDIO window to turn the LED ON

or OFF. A logic low will light up the LED you selected.
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e FLASHLED1.c—demonstrates the use of assembly language to flash LEDs DS1 and
DS2 on the Prototyping Board at different rates. Once you have compiled and run this
program, LEDs DS1 and DS2 will flash on/off at different rates.

e FLASHLED2.c—demonstrates the use of cofunctions and costatements to flash LEDs
DS1 and DS2 on the Prototyping Board at different rates. Once you have compiled and
run this program, LEDs DS1 and DS2 will flash on/off at different rates.

e TOGGLESWITCH.c—demonstrates the use of costatements to detect switches using the
press-and-release method of debouncing. LEDs DS1 and DS2 on the Prototyping
Board are turned on and off when you press switches S2 and S3. S2 and S3 are con-
trolled by PD5 and PD4 respectively.

e IR DEMO.c—Demonstrates sending Modbus ASCII packets between two Prototyping
Board assemblies via the IrDA transceivers with the IrDA transceivers facing each other.
Note that this sample program requires a second Prototyping Board or Rabbit Semicon-
ductor single-board computer that has an IrDA chip and is running the IR_DEMO.C
sample program associated with it.

First, compile and run the IR_DEMo. ¢ sample program from the saMpLES folder spe-
cific to the other system on the second system, then remove the programming cable and
press the RESET button so that the first assembly is operating in the Run mode. Then
connect the programming cable to the RCM3400 Prototyping Board, and compile and
run the IR_DEMO. ¢ sample program from the saAMPLES\RcM3400 folder on the
RCM3400 system. With the IrDA transceivers on the two Prototyping Boards facing
each other, press switch S2 on the RCM3400 Prototyping Board to transmit a packet.
The other system will return a response packet that will then appear in the Dynamic C
STDIO window. The test packets and response packets have different codes.

Once you have loaded and executed these five programs and have an understanding of
how Dynamic C and the RCM3400 modules interact, you can move on and try the other
sample programs, or begin building your own.

3.2.1 Serial Communication

The following sample programs are found in the sERIAL subdirectory in
SAMPLES\RCM3400.

e FLOWCONTROL.C—This program demonstrates how to configure Serial Port C for
CTS/RTS with serial data coming from Serial Port D (TxD) at 115,200 bps. The serial
data received are displayed in the STDIO window.

To set up the Prototyping Board, you will need to tie TxD and RxD
together on the RS-232 _header at J5, a'nd you will also tie TxC qnd Js
RxC together using the jumpers supplied in the Development Kit as 2B ol
shown in the diagram.

A repeating triangular pattern should print out in the STDIO window.
The program will periodically switch flow control on or off to demonstrate the effect of
no flow control.
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e PARITY.C—This program demonstrates the use of parity modes by
repeatedly sending byte values 0-127 from Serial Port D to Serial Port
C. The program will switch between generating parity or not on Serial
Port D. Serial Port C will always be checking parity, so parity errors
should occur during every other sequence.

RxCTxC
ofjo oo
-@ooo J5

TxDRxD GND

To set up the Prototyping Board, you will need to tie TxD and RxC together on the
RS-232 header at J5 using one of the jumpers supplied in the Development Kit as

shown in the diagram.
The Dynamic C STDIO window will display the error sequence.

e SIMPLE3WIRE.C—This program demonstrates basic RS-232 serial
communication. Lower case characters are sent by TxC, and are
received by RxD. The characters are converted to upper case and are
sent out by TxD, are received by RxC, and are displayed in the
Dynamic C STDIO window.

RxC TxC

aBncc v

TxD RxD GND

To set up the Prototyping Board, you will need to tie TXD and RxC together on the
RS-232 header at J5, and you will also tie RxD and TxC together using the jumpers

supplied in the Development Kit as shown in the diagram.

e SIMPLESWIRE.C—This program demonstrates 5-wire RS-232 serial communication

with flow control on Serial Port C and data flow on Serial Port D.

To set up the Prototyping Board, you will need to tie TxD and RxD
together on the RS-232 header at J5, and you will also tie TxC and
RxC together using the jumpers supplied in the Development Kit as
shown in the diagram.

Once you have compiled and run this program, you can test flow con-

RxC TxC

o[ES]o o
H -

TxD RxD GND

trol by disconnecting TxC from RxC while the program is running. Characters will no
longer appear in the STDIO window, and will display again once TxC is connected

back to RxC.

e SWITCHCHAR.C—This program demonstrates transmitting and then receiving an
ASCII string on Serial Ports D and C. It also displays the serial data received from both

ports in the STDIO window.

To set up the Prototyping Board, you will need to tie TxD and RxC
together on the RS-232 header at J5, and you will also tie RxD and
TXC together using the jumpers supplied in the Development Kit as
shown in the diagram.

Once you have compiled and run this program, press and release S2

RxC TxC

incC s

TxD RxD GND

and S3 on the Prototyping Board. The data sent between the serial ports will be dis-

played in the STDIO window.

Two sample programs, SIMPLE485MASTER. C and SIMPLE485SLAVE. C, are available to
illustrate RS-485 master/slave communication. To run these sample programs, you will

need a second Rabbit-based system with RS-485.
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The RS-485 connections between the slave and master devices are as follows.

* RS485+ to RS485+
* RS485-to RS485-
* GND to GND

e SIMPLE485MASTER.C—This program demonstrates a simple RS-485 transmission of
lower case letters to a slave. The slave will send back converted upper case letters back
to the master RCM3400 and display them in the STDIO window. Use
SIMPLE485SLAVE. C to program the slave.

e SIMPLE485SLAVE.C—This program demonstrates a simple RS-485 transmission of
lower case letters to a master RCM3400. The slave will send back converted upper case
letters back to the master RCM3400 and display them in the STDIO window. Use
SIMPLE485MASTER. C to program the master RCM3400.

3.2.2 A/D Converter Inputs
The following sample programs are found in the apc subdirectory in SAMPLES\RCM3400.

e AD CAL ALL.C—Demonstrates how to recalibrate all single-ended analog input chan-
nels for one gain, using two known voltages to generate the calibration constants for
each channel. Constants will be rewritten into the user block data area.

e AD CAL CHAN.C—Demonstrates how to recalibrate one single-ended analog input
channel with one gain using two known voltages to generate the calibration constants
for that channel. Constants will be rewritten into user block data area.

e AD CAL DIFF.C—Demonstrates how to recalibrate one differential analog input
channel using two known voltages to generate the calibration constants for that channel.
Constants will be rewritten into user block data area.

e AD CALMA CH.C—Demonstrates how to recalibrate an A/D input channel being used to
convert analog current measurements to generate the calibration constants for that channel.

NOTE: The above sample programs will overwrite any existing calibration constants.

e AD RDDIFF CH.C—Demonstrates how to read an A/D input channel being used for a
differential input using previously defined calibration constants.

e AD RDMA CH.C—Demonstrates how to read an A/D input channel being used to con-
vert analog current measurements using previously defined calibration constants for
that channel.

e AD RDVOLT ALL.C—Demonstrates how to read all single-ended A/D input channels
using previously defined calibration constants.

e AD SAMPLE.C—Demonstrates how to use a low-level driver on single-ended inputs.
The program will continuously display the voltage (average of 10 samples) that is
present on the A/D channels.

® ANAINCONFIG.C—Demonstrates how to use the Register Mode method to read single-
ended analog input values for display as voltages. The sample program uses the func-
tion call anaInconfig () and the ADS7870 CONVERT line to accomplish this task.
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e THERMISTOR.C—Demonstrates how to use analog input THERM_IN7 to calculate
temperature for display to the STDIO window. This sample program assumes that the
thermistor is the one included in the Development Kit whose values for beta, series
resistance, and resistance at standard temperature are given in the part specification.

e DNLOADCALIB.C—Demonstrates how to retrieve analog calibration data to rewrite it
back to simulated EEPROM in flash with using a serial utility such as Tera Term.

e UPLOADCALIB.C—Demonstrates how to read calibrations constants from the user
block in flash memory and then transmitting the file using a serial port and a PC serial
utility such as Tera Term. Use DNLOADCALIB. C to download the calibration constants
created by this program.

3.2.3 Real-Time Clock

If you plan to use the real-time clock functionality in your application, you will need to set
the real-time clock. Set the real-time clock using the SETRTCKB . ¢ sample program from
the Dynamic C sAMPLES\RTCLOCK folder, using the onscreen prompts. The
RTC_TEST. C sample program in the Dynamic C SAMPLES\RTCLOCK folder provides
additional examples of how to read and set the real-time clock.

3.2.4 TCP/IP Sample Programs

Sample programs demonstrating the TCP/IP associated with the Prototyping Board are
described in Appendix C.

3.2.5 LCD/Keypad Module Sample Programs
Sample programs for the optional LCD/keypad module are described in Appendix D.
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4. HARDWARE REFERENCE

Chapter 4 describes the hardware components and principal hardware
subsystems of the RCM3400. Appendix A, “RCM3400 Specifica-
tions,” provides complete physical and electrical specifications.

Figure 4 shows the Rabbit-based subsystems designed into the RCM3400.

External
A/D Converter scaling

circuitry

SRAM RABBIT® logic-level serial signal

3000
Flash
Level
converter
32 kHz | [29.4 MHz
ose ose RS-232, RS-485,
IrDA and Ethernet
RabbitCore Module drivers on motherboard

Figure 4. RCM3400 Subsystems
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4.1 RCM3400 Digital Inputs and Outputs
Figure 5 shows the RCM3400 pinouts for headers J1 and J2.

J2 J1
GND L[ |®m o[ 1PF1 LN3_|m o[ JLN7
PB6 |0 o| ]PFO LN2C|o o[ JLN6
PB5C |0 o| PB4 LN1Jo o[ JLN5
PB3 |0 o| 1PB2 LNOCJo o[ JLN4
PB1|o o[ ]PA7 VREF[—| o o[ ] CONVERT
PA6L |0 o[ ]PA5 PF6_|o ol 1PF7
PA4L |0 o[ ]PA3 PF4|o o[ JPF5
PA2 o o[ ] PA1 PB7 o o[ JPE7
pPCc2C o o[ 1PAO PE6 |0 o[ JPE5
PCOC] o o[ JPC3 PE4 o o[ JPE2
PC6-TxA | o o[ ] PC1 PE1|o o[ PEO
PC7-RXA[| o o[ PG3 GND[|o o[ J+33V_IN
PG2 |0 ol 1pPG1 PG7 o o[ 1PG6
PGO o o[ PDO PG5 |0 o[ PG4
PD4 o o[ 1PD5 /IORD ] o o[ ] STATUS
PD6L | o[ J/RESET_IN SMODE1L_|o o[ 1/IOWR
PD7 | o o[ 1VBAT EXT /RES[|o o[ ] SMODEO
n.c. = not connected
Note: These pinouts are as seen on
the Bottom Side of the module.

Figure 5. RCM3400 Pinouts

Headers J1 and J2 are standard 2 x 34 headers with a nominal 1.27 mm pitch.
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Figure 6 shows the use of the Rabbit 3000 microprocessor ports in the RCM3400 modules.

PC5*

/RES_IN
Misc. I/O /IORD

/RESET,

/IOWR,

PDO
PAO-PA7 PB1-PB7 PD4-PD7
Port A Port B Port D
PCO, PC2 Port C p PEO-PE2
ort E
PC1, PC3 ﬂ (Serial Ports C & D) RABB”® PE4-PE7
PG2, PG6 Port G 3000 Port F oFO_PFT
PG3. PG7 (Serial Ports E & F) PF4—PF7
PB1, PC6 Programming Real-Time Clock Port G
Sl " PGO-PG7
PC7, IRES “ (Serial Port A) iigiehdog (+Serial Ports)
11 Timers
PC4*§ A/D Converter Slave Port

* PC4 and PC5 are
not available on

RCM3400 I/O pins.

(Serial Port B) Clock Doubler
— o STATUS
ackup Battery SMODEO
RAM e Flash SMODET

The ports on the Rabbit 3000 microprocessor used in the RCM3400 are configurable, and
so the factory defaults can be reconfigured. Table 2 lists the Rabbit 3000 factory defaults

Figure 6. Use of Rabbit 3000 Ports

and the alternate configurations.
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Table 2. RCM3400 Pinout Configurations

Pin Pin Name Default Use Alternate Use Notes
1 LN3 Analog Input
2 LN7 Analog Input
3 LN2 Analog Input
4 LN6 Analog Input
AJD converter
5 LN1 Analog Input
6 LN5 Analog Input
7 LNO Analog Input
8 LN4 Analog Input
9 VREF Analog Output 1.15 \_//2.048 V/2.500 V
on-chip ref. voltage
10 CONVERT | Analog Input A/D converter
AQD2B
11 PF6 Input/Output PWM?2
AQD2A
12 PF7 Input/Output PWM3
=
& AQD1B
?‘3 13 PF4 Input/Output PWMO
T
AQD1A
14 PF5 Input/Output PWML
15 PB7 Inout/Outnut IA5 External Address 5
RIS ISLAVEATTN Slave Attention
17 I/O Strobe 7
16 PET Input/Output /SCS Slave Port Chip Select
17 PE6 Input/Output 16 1/0 Strobe 6
15 I/O Strobe 5
18 PE5 Input/Output
npututpu INT1B Interrupt 1B
14 I/O Strobe 4
19 PE4 Input/Output
pubrutpu INTOB Interrupt 0B
20 PE2 Input/Output 12 1/0 Strobe 2
11 1/0 Strobe 1
21 PE1 Input/Output
putiLte INTLA Interrupt 1A
10 1/O Strobe 0
22 PEO Input/Output
P P INTOA Interrupt OA
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Table 2. RCM3400 Pinout Configurations (continued)

Pin Pin Name Default Use Alternate Use Notes
23 GND
24 +3.3V_IN
25 PG7 Input/Output RXE
Serial Port E
26 PG6 Input/Output TXE
27 PG5 Input/Output RCLKE Serial Clock E input
28 PG4 Input/Output TCLKE Serial Clock E output
29 /IORD Input External read strobe
30 STATUS Output (Status) Output
(SMODE1, SMODEDOQ)
(0,0)—start executing at address zero
. (0,1)—cold boot from slave port
g 31 SMODEL (1,0)—cold boot from clocked Serial Port A Programming port
[553
T SMODEO =1, SMODE1 = 1
Cold boot from asynchronous Serial Port A at
2400 bps (programming cable connected)
32 /IOWR Output External write strobe
33 /IRES Reset output Reset input Reset output from Reset
Generator
(SMODE1, SMODEDOQ)
(0,0)—start executing at address zero
(0,1)—cold boot from slave port
34 SMODEO (1,0)—cold boot from clocked Serial Port A Programming port
SMODEO =1, SMODE1 =1
Cold boot from asynchronous Serial Port A at
2400 bps (programming cable connected)
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Table 2. RCM3400 Pinout Configurations (continued)

Pin Pin Name Default Use Alternate Use Notes
1 GND
QD1A
2 PF1 Input/Output CLKC
3 PB6 Input/Output 1A4 External Address 4
QD1B
4 PFO Input/Output CLKD
IA3 External Address 3
5 PB5 Input/Output xiermna ress
SAl Slave port Address 1
1A2 External Address 2
6 PB4 Input/Output
npuvLtpu SAO0 Slave port Address 0
1Al External Address 1
7 PB3 Input/Output
putoutpu /SRD Slave port read
IA0 External Address 0
8 PB2 Input/Output .
P P /SWR Slave port write
9 PB1 Input/Output CLKA
External data bus
ID7-1D1
N 110-16 |PA[7:1] Parallel 1/0 ( )
= Slave port data bus
?\3 (SD7-SD1)
T
17 PC2 Output TXC Serial Port C
External data bus (ID0) .
18 PAO Parallel 1/0 High
Slave port data bus (SD0) g
19 PCO Output TXD Serial Port D
20 PC3 Input RXC Serial Port C
21 PC6 Output TXA Programming port
22 PC1 Input RXD Serial Port D
23 PC7 Input RXA Programming port
24 PG3 Input/Output RXF
Serial Port F
25 PG2 Input/Output TXF
26 PG1 Input/Output RCLKF Serial Clock F input
27 PGO Input/Output TCLKF Serial Clock F output
28 PDO Input/Output
29 PD4 Input/Output ATXB
30 PD5 Input/Output ARXB
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Table 2. RCM3400 Pinout Configurations (continued)

Pin Pin Name Default Use Alternate Use Notes

31 PD6 Input/Output ATXA
§ 32 /RESET_IN | Input Input to Reset Generator
§ 33 PD7 Input/Output ARXA

34 VBAT_EXT
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4.1.1 Memory I/O Interface

The Rabbit 3000 address lines (A0-A19) and all the data lines (D0-D7) are routed inter-
nally to the onboard flash memory and SRAM chips. 1/0 write (/IOWR) and 1/0 read
(/IORD) are available for interfacing to external devices.

Parallel Port A can also be used as an external 1/0O data bus to isolate external 1/0 from the
main data bus. Parallel Port B pins PB2—PB7 can also be used as an auxiliary address bus.

When using the auxiliary 1/0 bus for either Ethernet or the LCD/keypad module on the
Prototyping Board or for any other reason, you must add the following line at the begin-
ning of your program.

#define PORTA AUX IO // required to enable auxiliary I/0 bus

4.1.2 Other Inputs and Outputs

The status, /RESET_IN, SMODEOQ, and SMODEZ1 1/0 are normally associated with the
programming port. Since the status pin is not used by the system once a program has been
downloaded and is running, the status pin can then be used as a general-purpose CMOS
output. The programming port is described in more detail in Section 4.2.2.

/RESET _IN is an external input used to reset the Rabbit 3000 microprocessor and the
RCM3400 memory. /RES is an output from the reset circuitry that can be used to reset
other peripheral devices.

The two SMODE pins, SMODEO and SMODEJ1, are available as inputs. The logic state of
these two pins determines the startup procedure after a reset.
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4.2 Serial Communication

The RCM3400 board does not have any serial transceivers directly on the board. How-
ever, an Ethernet or other serial interface may be incorporated on the board the RCM3400
is mounted on. For example, the Prototyping Board has RS-232, RS-485, IrDA, and
Ethernet transceiver chips.

4.2.1 Serial Ports

There are five serial ports designated as Serial Ports A, C, D, E, and F. All five serial ports
can operate in an asynchronous mode up to the baud rate of the system clock divided by 8.
An asynchronous port can handle 7 or 8 data bits. A 9th bit address scheme, where an
additional bit is sent to mark the first byte of a message, is also supported.

Serial Port A is normally used as a programming port, but may be used either as an asyn-
chronous or as a clocked serial port once application development has been completed and
the RCM3400 is operating in the Run Mode.

Serial Port B is used by the A/D converter, and is not available for other use off the
RCM3400.

Serial Ports C and D can also be operated in the clocked serial mode. In this mode, a clock
line synchronously clocks the data in or out. Either of the two communicating devices can
supply the clock.

Serial Ports E and F can also be configured as SDLC/HDLC serial ports. The IrDA proto-
col is also supported in SDLC format by these two ports.

4.2.2 Programming Port

The RCM3400 serial programming port is accessed via the 10-pin header labeled J2 on
the Prototyping Board or over an Ethernet connection via the RabbitLink EG2110. The
programming port uses the Rabbit 3000°s Serial Port A for communication. Dynamic C
uses the programming port to download and debug programs.

The programming port is also used for the following operations.
e Cold-boot the Rabbit 3000 on the RCM3400 after a reset.

e Remotely download and debug a program over an Ethernet connection using the
RabbitLink EG2110.

e Fast copy designated portions of flash memory from one Rabbit-based board (the
master) to another (the slave) using the Rabbit Cloning Board.

If the Prototyping Board is not used, programming must be initiated through the mother-
board to which the RCM3400 module is plugged in to since the Serial Port A (PC6 and
PC7), SMODEO, SMODEL1, and /RESET _IN are available on headers J1 and J2 (see
Table 2).
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Alternate Uses of the Programming Port

All three clocked Serial Port A signals are available as

e asynchronous serial port

¢ an asynchronous serial port, with the clock line usable as a general CMOS 1/0O pin

The programming port may also be used as a serial port via the DIAG connector on the
programming cable.

In addition to Serial Port A, the Rabbit 3000 startup-mode (SMODEQO, SMODEL1), status,
and reset pins are available on the programming port.

The two startup mode pins determine what happens after a reset—the Rabbit 3000 is
either cold-booted or the program begins executing at address 0x0000.

The status pin is used by Dynamic C to determine whether a Rabbit microprocessor is
present. The status output has three different programmable functions:

1. It can be driven low on the first op code fetch cycle.
2. It can be driven low during an interrupt acknowledge cycle.
3. It can also serve as a general-purpose output.

The /RESET _IN pin is an external input that is used to reset the Rabbit 3000 and the
RCM3400 onboard peripheral circuits. The serial programming port can be used to force a
hard reset on the RCM3400 by asserting the /RESET _IN signal.

Refer to the Rabbit 3000 Microprocessor User’s Manual for more information.
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4.3 Serial Programming Cable

The programming cable is used to connect the serial programming port of the RCM3400
to a PC serial COM port. The programming cable converts the RS-232 voltage levels used
by the PC serial port to the CMOS voltage levels used by the Rabbit 3000.

When the PROG connector on the programming cable is connected to the programming
header on the RCM3400 Prototyping Board, programs can be downloaded and debugged
over the serial interface.

The DIAG connector of the programming cable may be used on header J2 of the RCM3400
Prototyping Board with the RCM3400 operating in the Run Mode. This allows the pro-
gramming port to be used as a regular serial port.

4.3.1 Changing Between Program Mode and Run Mode

The RCM3400 is automatically in Program Mode when the PROG connector on the pro-
gramming cable is attached, and is automatically in Run Mode when no programming
cable is attached. When the Rabbit 3000 is reset, the operating mode is determined by the
status of the SMODE pins. When the programming cable’s PROG connector is attached,
the SMODE pins are pulled high, placing the Rabbit 3000 in the Program Mode. When the
programming cable’s PROG connector is not attached, the SMODE pins are pulled low,
causing the Rabbit 3000 to operate in the Run Mode.

Q.

g Programming
3 [T “cable
c

<

%]

Blue

)102010.0.0.0.0.00.6,0.0:0.0.0.0.0.0.0.0.9 |

000000000000000000000000000

AARARARARARAAARARARARARARAARA

RESET RCM3400 when changing mode:

Short out pins 1-32 on header J2, OR

Press RESET button (if using Prototyping Board), OR
Cycle power off/on

after removing or attaching programming cable.

Figure 7. Switching Between Program Mode and Run Mode
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A program “runs” in either mode, but can only be downloaded and debugged when the
RCM3400 is in the program mode.

Refer to the Rabbit 3000 Microprocessor User’s Manual for more information on the pro-
gramming port and the programming cable.

4.3.2 Standalone Operation of the RCM3400

The RCM3400 must be programmed via the RCM3400 Prototyping Board or via a similar
arrangement on a customer-supplied board. Once the RCM3400 has been programmed
successfully, remove the programming cable from the programming connector and reset
the RCM3400. The RCM3400 may be reset by cycling power off/on or by pressing the
RESET button on the Prototyping Board. The RCM3400 module may now be removed
from the Prototyping Board for end-use installation.

CAUTION: Power to the Prototyping Board or other boards should be disconnected
when removing or installing your RCM3400 module to protect against inadvertent
shorts across the pins or damage to the RCM3400 if the pins are not plugged in cor-
rectly. Do not reapply power until you have verified that the RCM3400 module is
plugged in correctly.
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4.4 A/D Converter

The RCM3400 has an onboard ADS7870 A/D converter whose scaling and filtering are
done via the motherboard on which the RCM3400 module is mounted. The A/D converter
multiplexes converted signals from eight single-ended or four differential inputs to Serial
Port B on the Rabbit 3000.

The eight analog input pins, LNO-LN7, each have an input impedance of 6-7 MQ,
depending on whether they are used as single-ended or differential inputs. The input signal
can range from -2 V to +2 V (differential mode) or from 0 V to +2 V (single-ended mode).

Use a resistor divider such as the one shown in Figure 8 for the analog inputs.

N RCM3400

R10

LNO ADC
- LN1 L —

R11

[L1,
I

AGND

Figure 8. Resistor Divider Network for Analog Inputs

RO and R1 are typically 20 k< to 100 k<, with a lower resistance leading to more accu-
racy, but at the expense of a higher current draw. R10 and R11 would then be 180 k< to
900 kQ for a 10:1 attenuator. The capacitor filters noise pulses on the A/D converter input.

The actual voltage range for a signal going to the A/D converter input is also affected by
the 1, 2, 4, 5. 8, 10, 16, and 20 V/V software-programmable gains available on each chan-
nel of the ADS7870 A/D converter. Thus, you must scale the analog signal with an attenu-
ator circuit and a software-programmable gain so that the actual input presented to the
A/D converter is within the range limits of the ADS7870 A/D converter chip ((2Vto+2V
orOVito+2V).

The A/D converter chip can only accept positive voltages. With resistors RO and R1 con-
nected to ground, your analog circuit is well-suited to perform positive A/D conversions.
When RO and R1 are tied to ground for differential measurements, both differential inputs

must be referenced to analog ground, and both inputs must be positive with respect to ana-
log ground.

User’s Manual 31



If a device such as a battery is
connected across two channels
for a differential measurement,
and it is not referenced to
analog ground, then the current
from the device will flow
through both sets of attenuator
resistors as shown in Figure 9.
This will generate a negative
voltage at one of the inputs,
LN1, which will almost cer- Figure 9. Current Flow from Ungrounded

tainly lead to inaccurate A/D or Floating Source

conversions. To make such dif-

ferential measurements, connect RO and R1 to the A/D converter’s internal reference volt-
age, which is software-configurable for 1.15V, 2.048 V, or 2.5 V. This internal reference
voltage is available on pin 9 of header J1 as VREF, and allows you to convert analog input
voltages that are negative with respect to analog ground.

wo ADC

LN1

NOTE: The amplifier inside the A/D converter’s internal voltage reference circuit has a
very limited output-current capability. The internal buffer can source up to 20 mA and
sink only up to 20 pA. Use a separate buffer amplifier if you need to supply any load
current.

The A/D converter’s CONVERT pin is available on pin 10 of header J1 and can be used as
a hardware means of forcing the A/D converter to start a conversion cycle. The CONVERT
signal is an edge-triggered event and has a hold time of two CCLK periods for debounce.

A conversion is started by an active (rising) edge on the CONVERT pin. The CONVERT
pin must stay low for at least two CCLK periods before going high for at least two CCLK
periods. Figure 10 shows the timing of a conversion start. The double falling arrow on
CCLK indicates the actual start of the conversion cycle.

Conversion starts

|
cok \ NS\ S\

BUSY /
CONV / \

Figure 10. Timing Diagram for Conversion Start Using CONVERT Pin

Appendix B explains the implementation examples of these features on the Prototyping
Board.
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4.4.1 A/D Converter Calibration

All single-ended inputs are factory-calibrated with actual voltages at a gain code of 0.
Typical values for the other gain codes and for other calibration constants for current and
differential measurements are used to populate the table to allow A/D conversions to be
done “out of the box.” See Appendix B.4.3.3 for information on performing your own cal-
ibrations in situations where you require enhanced accuracy.

4.4.2 A/D Converter Power Supply

The analog section is isolated from digital noise generated by other components by way of a
low-pass filter composed of L1, C10, and C15 on the RCM3400 as shown in Figure 11. The
+V analog power supply powers the A/D converter chip.

Vce +V

L1

C15 C10

:[2.2 nF ]:100 nF

Figure 11. Analog Supply Circuit
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4.5 Other Hardware
45.1 Clock Doubler

The RCM3400 takes advantage of the Rabbit 3000 microprocessor’s internal clock dou-
bler. A built-in clock doubler allows half-frequency crystals to be used to reduce radiated
emissions. The 29.4 MHz frequency specified for the RCM3400 is generated using a
14.7 MHz resonator.

The clock doubler may be disabled if 29.4 MHz clock speeds are not required. Disabling
the Rabbit 3000 microprocessor’s internal clock doubler will reduce power consumption
and further reduce radiated emissions. The clock doubler is disabled with a simple config-
uration macro as shown below.

1. Select the “Defines” tab from the Dynamic C Options > Project Options menu.
2. Add the line CLOCK_DOUBLED=0 to always disable the clock doubler.

The clock doubler is enabled by default, and usually no entry is needed. If you need to
specify that the clock doubler is always enabled, add the line CLOCK DOUBLED=1 t0o
always enable the clock doubler.

3. Click OK to save the macro. The clock doubler will now remain off whenever you are
in the project file where you defined the macro.

The clock doubler must be disabled for low-voltage operation (2.8 V-3.0 V).
4.5.2 Spectrum Spreader

The Rabbit 3000 features a spectrum spreader, which helps to mitigate EMI problems. The
spectrum spreader is on by default, but it may also be turned off or set to a stronger setting.
The means for doing so is through a simple configuration macro as shown below.

1. Select the “Defines” tab from the Dynamic C Options > Project Options menu.

2. Normal spreading is the default, and usually no entry is needed. If you need to specify
normal spreading, add the line

ENABLE SPREADER=1

For strong spreading, add the line
ENABLE SPREADER=2

To disable the spectrum spreader, add the line
ENABLE SPREADER=0

NOTE: The strong spectrum-spreading setting is unnecessary for the BL2000.

3. Click OK to save the macro. The spectrum spreader will now remain off whenever you
are in the project file where you defined the macro.

NOTE: Refer to the Rabbit 3000 Microprocessor User’s Manual for more information
on the spectrum-spreading setting and the maximum clock speed.
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4.6 Memory

4.6.1 SRAM

RCM3400 boards have 256K-512K of SRAM installed at U6.

4.6.2 Flash EPROM

RCM3400 boards also have 256K-512K of flash EPROM installed at U4.

NOTE: Rabbit Semiconductor recommends that any customer applications should not be
constrained by the sector size of the flash EPROM since it may be necessary to change
the sector size in the future.

Writing to arbitrary flash memory addresses at run time is also discouraged. Instead,
define a “user block” area to store persistent data. The functions writeUserBlock and
readUserBlock are provided for this. Refer to the Rabbit 3000 Microprocessor
Designer’s Handbook for additional information.

A Flash Memory Bank Select jumper configuration option based on 0 Q surface-mounted
resistors exists at header JP2 on the RCM3400 modules. This option is reserved for future
use.

4.6.3 Dynamic C BIOS Source Files

The Dynamic C BIOS source files handle different standard RAM and flash EPROM sizes
automatically.
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5. SOFTWARE REFERENCE

Dynamic C is an integrated development system for writing
embedded software. It runs on an IBM-compatible PC and is
designed for use with Rabbit Semiconductor controllers and
other controllers based on the Rabbit microprocessor. Chapter 5
provides the libraries, function calls, and sample programs
related to the RCM3400.

5.1 More About Dynamic C

Dynamic C has been in use worldwide since 1989. It is specially designed for program-
ming embedded systems, and features quick compile and interactive debugging in the real
environment. A complete reference guide to Dynamic C is contained in the Dynamic C
User’s Manual.

You have the choice of doing your software development in the flash memory or in the
static SRAM included on the RCM3400. The flash memory and SRAM options are
selected with the Options > Compiler menu.

The advantage of working in RAM is to save wear on the flash memory, which is limited
to about 100,000 write cycles. The disadvantage is that the code and data might not both
fitin RAM.

NOTE: An application can be developed in RAM, but cannot run standalone from RAM
after the programming cable is disconnected. All standalone applications can only run
from flash memory.

NOTE: Do not depend on the flash memory sector size or type. Due to the volatility of
the flash memory market, the RCM3400 and Dynamic C were designed to accommo-
date flash devices with various sector sizes.

Developing software with Dynamic C is simple. Users can write, compile, and test C and
assembly code without leaving the Dynamic C development environment. Debugging
occurs while the application runs on the target. Alternatively, users can compile a program
to an image file for later loading. Dynamic C runs on PCs under Windows 95, 98, 2000,
NT, Me, and XP. Programs can be downloaded at baud rates of up to 460,800 bps after the
program compiles.
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Dynamic C has a number of standard features:

Full-feature source and/or assembly-level debugger, no in-circuit emulator required.
Royalty-free TCP/IP stack with source code and most common protocols.

Hundreds of functions in source-code libraries and sample programs:

» Exceptionally fast support for floating-point arithmetic and transcendental functions.
» RS-232 and RS-485 serial communication.

» Analog and digital 1/O drivers.

» 12C, SPI, GPS, file system.

» LCD display and keypad drivers.

Powerful language extensions for cooperative or preemptive multitasking

Loader utility program to load binary images into Rabbit Semiconductor targets in the
absence of Dynamic C.

Provision for customers to create their own source code libraries and augment on-line
help by creating “function description” block comments using a special format for
library functions.

Standard debugging features:

» Breakpoints—Set breakpoints that can disable interrupts.
» Single-stepping—Step into or over functions at a source or machine code level, uC/OS-Il aware.

» Code disassembly—The disassembly window displays addresses, opcodes, mnemonics, and
machine cycle times. Switch between debugging at machine-code level and source-code level by
simply opening or closing the disassembly window.

P Watch expressions—Watch expressions are compiled when defined, so complex expressions
including function calls may be placed into watch expressions. Watch expressions can be updated
with or without stopping program execution.

» Register window—All processor registers and flags are displayed. The contents of general registers
may be modified in the window by the user.

» Stack window—shows the contents of the top of the stack.
» Hex memory dump—displays the contents of memory at any address.

» STDIO window—print£ outputs to this window and keyboard input on the host PC can be
detected for debugging purposes. print £ output may also be sent to a serial port or file.
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5.2 Dynamic C Function Calls
5.2.1 Digital I/0

The RCM3400 was designed to interface with other systems, and so there are no drivers
written specifically for the 1/0. The general Dynamic C read and write functions allow
you to customize the parallel 1/0 to meet your specific needs. For example, use

WrPortI (PEDDR, &PEDDRShadow, 0x00);

to set all the Port E bits as inputs, or use

WrPortI (PEDDR, &PEDDRShadow, OxFF);

to set all the Port E bits as outputs.

When using the auxiliary 1/0 bus on the Rabbit 3000 chip, add the line

#define PORTA AUX IO // required to enable auxiliary I/O bus

to the beginning of any programs using the auxiliary 1/0 bus.

The sample programs in the Dynamic C saMPLES/RCM3400 directory provide further
examples.

5.2.2 Serial Communication Drivers

Library files included with Dynamic C provide a full range of serial communications sup-
port. The Rs232.LIB library provides a set of circular-buffer-based serial functions. The
PACKET .LIB library provides packet-based serial functions where packets can be delim-
ited by the 9th bit, by transmission gaps, or with user-defined special characters. Both
libraries provide blocking functions, which do not return until they are finished transmit-
ting or receiving, and nonblocking functions, which must be called repeatedly until they
are finished. For more information, see the Dynamic C Function Reference Manual and
Technical Note 213, Rabbit 2000 Serial Port Software.

5.2.3 TCP/IP Drivers
The TCP/IP drivers are located in the TCPIP directory.

Complete information on these libraries and the TCP/IP functions is provided in the
Dynamic C TCP/IP User’s Manual.
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5.2.4 Prototyping Board Function Calls

The functions described in this section are for use with the Prototyping Board features.
The source code is in the ReM34xx . LIB library in the Dynamic C LiB\RcM3400 folder if
you need to modify it for your own board design.

Other generic functions applicable to all devices based on Rabbit microprocessors are
described in the Dynamic C Function Reference Manual.

5.2.5 Board Initialization
void brdInit (wvoid);

Call this function at the beginning of your program. This function initializes Parallel Ports A through G
for use with the RCM3400 Prototyping Board.

Summary of Initialization
1. Display/keypad select is disabled.
2. Ethernet select is disabled.
3. RS-485 is not enabled.
4. RS-232 is not enabled.
5. Unused configurable 1/O are tied inputs or outputs set low.
6. A/D converter is reset and SCLKB is set to 57,600 bps.
7.A/D converter calibration constants are read, so this function cannot run in RAM.

RETURN VALUE
None.
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5.2.6 Analog Inputs

unsigned int anaInConfig(unsigned int
instructionbyte, unsigned int cmd, long baud) ;

Use this function to configure the A/D converter. This function will address the A/D converter in
Register Mode only, and will return an error if you try the Direct Mode. Appendix B.4.3 provides
additional addressing and command information.

ADS7870 Signal | ADS7870 State RCM3400 Function/State
LNO Input AINO
LN1 Input AIN1
LN2 Input AIN2
LN3 Input AIN3
LN4 Input AIN4
LN5 Input AINS
LNG6 Input AING
LN7 Input AIN7
/RESET Input Board reset device
RISE/FALL Input Pulled up for SCLK active on rising edge
P100 Input Pulled down
PIO1 Input Pulled down
P102 Input Pulled down
P103 Input Pulled down
CONVERT Input Pulled down
BUSY Output PD1 pulled down; logic high state converter is busy
CCLKCNTRL Input Pulled down; O state sets CCLK as input
CCLK Input Pulled down; external conversion clock
SCLK Input PBO; serial data transfer clock
SDI Input PC4; 3-wire mode for serial data input
SDO Output PC5; serial data output /CS driven
ICS Input PD2 pulled up; active-low enables serial interface
BUFIN Input Pulled down; reference buffer amplifier
VREF Output Connected to BUFIN
BUFOUT Output Pulled down
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PARAMETERS
instructionbyte is the instruction byte that will initiate a read or write operation at 8 or 16 bits on

the designated register address. For example,
checkid = anaInConfig (0x5F, 0, 9600); // read ID and set baud rate
cmd are the command data that configure the registers addressed by the instruction byte. Enter O if you
are performing a read operation. For example,
i = anaInConfig(0x07, 0x3b, 0); // write ref/osc reg and enable
baud is the serial clock transfer rate of 9600 to 57,600 bps. baud must be set the first time this function
is called. Enter O for this parameter thereafter, for example,
anaInConfig(0x00, 0x00, 9600); // resets device and sets baud
RETURN VALUE

0 on write operations,
data value on read operations

SEE ALSO
anaInDriver, analn, brdInit
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unsigned int anaInDriver (unsigned int cmd,
unsigned int 1len) ;

Reads the voltage of an analog input channel by serial-clocking an 8-bit command to the A/D converter
by its Direct Mode method. This function assumes that Model (most significant byte first) and the A/D
converter oscillator have been enabled. See anaInConfig () for the setup.

The conversion begins immediately after the last data bit has been transferred. An exception error will
occur if Direct Mode bit D7 is not set.

PARAMETERS
cmd contains a gain code and a channel code as follows.
D7—1; D6-D4—Gain Code; D3-D0—Channel Code
Use the following calculation and the tables below to determine emd:

cmd = 0x80 | (gain code*16) + channel code

Gain Code Multiplier

0 x1

1 %2

2 x4

3 x5

4 x8

5 x10

6 x16

7 x20

Channel Code Differi?r:i(i Input Channel Code Sllnnpgulf_LEi:::? 4_ingens1A

0 +AINO -AIN1 8 AINO AINO*
1 +AIN2 -AIN3 9 AIN1 AIN1*
2 +AIN4 -AIN5 10 AIN2 AIN2*
3t +AING -AIN7 11 AIN3 AIN3
4 -AINO +AIN1 12 AIN4 AIN4
5 -AIN2 +AIN3 13 AIN5 AIN5
6 -AIN4 +AIN5 14 AING6 AING6
Ve -AING6 +AIN7 15 AIN7 AINT*

* Negative input is ground.
t Not accessible on Prototyping Board

len, the output bit length, is always 12 for 11-bit conversions
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RETURN VALUE
A value corresponding to the voltage on the analog input channel:
0-2047 for 11-bit conversions (bit 12 for sign)

-1 overflow or out of range
-2 conversion incomplete, busy bit timeout

SEE ALSO

anaInConfig, anaIn, brdInit
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unsigned int analIn(unsigned int channel,
int opmode, int gaincode) ;
Reads the value of an analog input channel using the direct method of addressing the A/D converter.

Note that it takes about 1 second to ensure an internal capacitor on the A/D converter is charged when the
function is called the first time.

PARAMETERS
channel is the channel number (0 to 7) corresponding to ADC_INO to ADC_IN7
opmode is the mode of operation:

SINGLE—single-ended input
DIFF—differential input
mAMP—4-20 mA input

channel SINGLE DIFF mAMP
0 +AINO +AINO -AIN1 +AINO”
1 +AIN1 +AIN1 -AINO* +AIN1*
2 +AIN2 +AIN2 -AIN3 +AIN2*
3 +AIN3 +AIN3 -AIN2* +AIN3
4 +AIN4 +AIN4 -AIN5 +AIN4
5 +AIN5 +AIN5 -AIN4* +AIN5
6 +AIN6 +AIN6 -AIN7* +AIN6
7 +AIN7 +AIN7 -AING* +AINT*

* Not accessible on Prototyping Board.

gaincode is the gain code of 0 to 7 (applies only to Prototyping Board):

Gain Code | Multiplier | Voltage Range

V)

0 x1 0-20

1 x2 0-10

2 x4 0-5

3 x5 0-4

4 %8 0-2.5

5 x10 0-2

6 x16 0-1.25

7 x20 0-1

RETURN VALUE
A value corresponding to the voltage on the analog input channel:
0-2047 for 11-bit A/D conversions (bit 12 for sign)

ADOVERFLOW (defined macro = -4096) if overflow or out of range
ADTIMEOUT (defined macro = -4095) if conversion is incomplete or busy-bit timeout

SEE ALSO

analIn, anaInConfig, anaInDriver
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int anaInCalib (int channel, int opmode,
int gaincode, int valuel, float voltsl,
int value2, float volts2);

Calibrates the response of the desired A/D converter channel as a linear function using the two conver-
sion points provided. Four values are calculated and placed into global tables adcCalibs,
_adcCalibD, and adcCalibM to be later stored into simulated EEPROM using the function
anaInEEWr (). Each channel will have a linear constant and a voltage offset.

PARAMETERS
channel is the analog input channel number (0 to 7) corresponding to ADC_INO to ADC_IN7
opmode is the mode of operation:

SINGLE—single-ended input
DIFF—differential input
mAMP—milliamp input

channel SINGLE DIFF mAMP
0 +AINO +AINO -AIN1 +AINO"
1 +AIN1 +AIN1 -AINO* +AIN1*
2 +AIN2 +AIN2 -AIN3 +AIN2*
3 +AIN3 +AIN3 -AIN2* +AIN3
4 +AIN4 +AIN4 -AIN5 +AIN4
5 +AIN5 +AINS5 -AIN4* +AIN5
6 +AING +AING -AIN7* +AIN6
7 +AIN7 +AIN7 -AIN6* +AIN7*

* Not accessible on Prototyping Board.

gaincode is the gain code of 0 to 7:

Gain Code Multiplier Voltage Range’

V)

0 x1 0-20

1 x2 0-10

2 x4 0-5

3 x5 0-4

4 %8 0-2.5

5 %10 0-2

6 x16 0-1.25

7 %20 0-1

* Applies to Prototyping Board.
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valuel is the first A/D converter channel raw count value

voltsl is the voltage or current corresponding to the first A/D converter channel value (0 to +20 V or
4 t0 20 mA)

value2 is the second A/D converter channel raw count value

voltsz2 is the voltage or current corresponding to the first A/D converter channel value (0 to +20 V or
4 t0 20 mA)

RETURN VALUE
0 if successful.
-1 if not able to make calibration constants.

SEE ALSO
anaIn, anaInVolts, anaInmAmps, anaInDiff, anaInCalib, brdInit
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float anaInVolts (unsigned int channel,
unsigned int gaincode) ;

Reads the state of a single-ended analog input channel and uses the previously set calibration constants to
convert it to volts.

PARAMETERS
channel is the channel number (0 to 7) corresponding to ADC_INO to ADC_IN7

Channel Code Single-E_ndefI Voltage Range'

Input Lines V)
0 +AINO 0-20
1 +AIN1 0-20
2 +AIN2 0-20
3 +AIN3 0-20
4 +AIN4 0-20
5 +AIN5 0-20
6 +AING 0-20
7 +AIN7 0—2%

* Negative input is ground.
t Applies to Prototyping Board.
1 Used for thermistor in sample program.

gaincode is the gain code of 0 to 7.

Gain Code | Multiplier | Voltage Range’

V)

0 x1 0-20

1 x2 0-10

2 x4 0-5

3 x5 0-4

4 x8 0-25

5 x10 0-2

6 x16 0-1.25

7 x20 0-1

* Applies to RCM3400 Prototyping Board.
RETURN VALUE
A voltage value corresponding to the voltage on the analog input channel.
ADOVERFLOW (defined macro = -4096) if overflow or out of range.

ADTIMEOUT (defined macro = -4095) if conversion is incomplete or busy-bit timeout.

SEE ALSO
anaInCalib, anaIn, anaInmAmps, brdInit
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float anaInDiff (unsigned int channel,
unsigned int gaincode) ;

Reads the state of differential analog input channels and uses the previously set calibration constants to

convert it to volts.

PARAMETERS

channel is the analog input channel number (0 to 7) corresponding to ADC_INO to ADC_IN7

gaincode is the gain code of 0 to 7.

RETURN VALUE

A voltage value corresponding to the voltage differential on the analog input channel.

channel DIFF Voltage Range
V)

0 +AINO -AIN1 20 t0 +20"
1 +AIN1 -AIN1 _
2 +AIN2 -AIN3 -20 to +20*
3 +AIN3 -AIN3 _
4 +AIN4 -AIN5 -20 to +20*
5 +AIN5 -AIN5 _
6 +AING -AIN7 _
7 +AIN7 -AIN7 _

* Accessible on Prototyping Board.

Gain Code | Multiplier | Voltage Range’
V)

0 x1 -20 - +20
1 x2 -10 - +10
2 x4 5-+5

3 x5 -4-+4

4 x8 25-+25
5 x10 Y

6 x16 -1.25-+1.25
7 x20 1-+1

* Applies to Prototyping Board.

ADOVERFLOW (defined macro = -4096) if overflow or out of range.

ADTIMEOUT (defined macro = -4095) if conversion is incomplete or busy-bit timeout.

SEE ALSO

anaInCalib, analIn, anaInmAmps, brdInit
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float anaInmAmps (unsigned int channel) ;

Reads the state of an analog input channel and uses the previously set calibration constants to convert it
to current.

PARAMETERS
channel is the channel number (0-7):

4-20 mA
Input Lines”

+AINO
+AIN1
+AIN2

Channel Code

+AIN3T
+AIN4*
+AIN5*
+AING*
+AIN7

N o o M~ W[N], O

* Negative input is ground.
t Applies to Prototyping Board.

RETURN VALUE
A current value between 4.00 and 20.00 mA corresponding to the current on the analog input channel.

ADOVERFLOW (defined macro = -4096) if overflow or out of range.

ADTIMEOUT (defined macro = -4095) if conversion is incomplete or busy-bit timeout.

SEE ALSO

anaInCalib, anaIn, analInVolts
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root int anaInEERd (unsigned int channel,

unsigned int opmode, unsigned int gaincode) ;

Reads the calibration constants, gain, and offset for an input based on their designated position in the
simulated EEPROM area of the flash memory, and places them into global tables adccCalibs,

adcCalibD, and adcCalibM for analog inputs. The constants are stored in the top 2K of the user

block in a reserved memory area. Depending on the flash size, the following macros can be used to
identify the starting address for these locations.

ADC CALIB_ADDRS, address start of single-ended analog input channels
ADC CALIB_ADDRD, address start of differential analog input channels

ADC CALIB_ADDRM, address start of milliamp analog input channels

NOTE: This function cannot be run in RAM.

PARAMETER

channel is the analog input channel number (0 to 7) corresponding to ADC_INO to ADC_IN7.

opmode is the mode of operation:

SINGLE—single-ended input line

DIFF—differential input line

mAMP—milliamp input line

channel SINGLE DIFF mAMP
0 +AINO +AINO -AIN1 +AINO"
1 +AIN1 +AIN1 -AINO* +AIN1*
2 +AIN2 +AIN2 -AIN3 +AIN2*
3 +AIN3 +AIN3 -AIN2* +AIN3
4 +AIN4 +AIN4 -AIN5 +AIN4
5 +AIN5 +AINS5 -AIN4* +AINS
6 +AING6 +AING6 -AIN7* +AING6
7 +AIN7 +AIN7 -AIN6* +AINT7*

ALLCHAN read all channels for selected opmode

* Not accessible on Prototyping Board.
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gaincode is the gain code of 0 to 7. The gaincode parameter is ignored when channel is ALLCHAN.

Gain Code | Voltage Range’
V)

0-20
0-10
0-5
0-4
0-2.5
0-2
0-1.25
0-1

~N| oo b~ WO DN, O

* Applies to Prototyping Board.

RETURN VALUE
0 if successful.
-1 if address is invalid or out of range.

SEE ALSO

anaInEEWr, anaInCalib
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int anaInEEWr (unsigned int channel, int opmode
unsigned int gaincode) ;

Writes the calibration constants, gain, and offset for an input based from global tables adcCalibs,
_adcCalibD, and _adcCalibM to designated positions in the simulated EEPROM area of the flash
memory. The constants are stored in the top 2K of the user block in a reserved memory area. Depending
on the flash size, the following macros can be used to identify the starting address for these locations.

ADC CALIB_ADDRS, address start of single-ended analog input channels
ADC CALIB_ADDRD, address start of differential analog input channels

ADC CALIB_ADDRM, address start of milliamp analog input channels

NOTE: This function cannot be run in RAM.
PARAMETER
channel is the analog input channel number (0 to 7) corresponding to ADC_INO to ADC_IN7.
opmode is the mode of operation:

SINGLE—single-ended input line
DIFF—differential input line
mAMP—milliamp input line

channel SINGLE DIFF mAMP
0 +AINO +AINO -AIN1 +AINO”
1 +AIN1 +AIN1 -AINO* +AIN1*
2 +AIN2 +AIN2 -AIN3 +AIN2*
3 +AIN3 +AIN3 -AIN2* +AIN3
4 +AIN4 +AIN4 -AINS +AIN4
5 +AINS +AINS5 -AIN4* +AINS
6 +AIN6 +AING -AINT7* +AIN6
7 +AIN7 +AIN7 -AIN6* +AINT7*

ALLCHAN read all channels for selected opmode

* Not accessible on Prototyping Board.
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gaincode is the gain code of 0 to 7. The gaincode parameter is ignored when channel is ALLCHAN.

Gain Code

Voltage Range”
V)

0-20

0-10

0-5

0-4

0-2.5

0-2

0-1.25

N oo b~ W N, O

0-1

* Applies to Prototyping Board.

RETURN VALUE
0 if successful
-1 if address is invalid or out of range.

SEE ALSO

anaInEEWr, anaInCalib
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5.3 Upgrading Dynamic C

Dynamic C patches that focus on bug fixes are available from time to time. Check the Web
site www.rabbit.com/support/ for the latest patches, workarounds, and bug fixes.

The default installation of a patch or bug fix is to install the file in a directory (folder) dif-
ferent from that of the original Dynamic C installation. Rabbit Semiconductor recom-
mends using a different directory so that you can verify the operation of the patch without
overwriting the existing Dynamic C installation. If you have made any changes to the
BIOS or to libraries, or if you have programs in the old directory (folder), make these
same changes to the BIOS or libraries in the new directory containing the patch. Do not
simply copy over an entire file since you may overwrite a bug fix. Once you are sure the
new patch works entirely to your satisfaction, you may retire the existing installation, but
keep it available to handle legacy applications.

5.3.1 Upgrades

Dynamic C installations are designed for use with the board they are included with, and
are included at no charge as part of our low-cost kits. Dynamic C is a complete software
development system, but does not include all the Dynamic C features. Rabbit Semicon-
ductor also offers add-on Dynamic C modules containing the popular uC/OS-I1 real-time
operating system, as well as PPP, Advanced Encryption Standard (AES), and other select
libraries. In addition to the Web-based technical support included at no extra charge, a
one-year telephone-based technical support module is also available for purchase.
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APPENDIX A. RCM3400 SPECIFICATIONS

Appendix A provides the specifications for the RCM3400, and
describes the conformal coating.
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A.1 Electrical and Mechanical Characteristics

Figure A-1 shows the mechanical dimensions for the RCM3400.

Please refer to the RCM3400
footprint diagram later in this
appendix for precise header

locations.
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Figure A-1. RCM3400 Dimensions
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It is recommended that you allow for an “exclusion zone” of 0.04" (1 mm) around the
RCM3400 in all directions when the RCM3400 is incorporated into an assembly that
includes other printed circuit boards. This “exclusion zone” that you keep free of other
components and boards will allow for sufficient air flow, and will help to minimize any
electrical or electromagnetic interference between adjacent boards. An “exclusion zone
of 0.08" (2 mm) is recommended below the RCM3400 when the RCM3400 is plugged
into another assembly using the shortest connectors for headers J1 and J2. Figure A-2

shows this “exclusion zone.”

004
(1)

0.086
(2.2)

i o ——
s (M T
) =

1.375 J1
> (34.9)

(1)

Exclusion
Zone

O ~
g3 | | | |-
0.04 1.160 0.04
(1) (29.5) (1)

Figure A-2. RCM3400 “Exclusion Zone”
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Table A-1 lists the electrical, mechanical, and environmental specifications for the RCM3400.

Table A-1. RabbitCore RCM3400 Specifications

Parameter RCM3400 RCM3410
Microprocessor Low-EMI Rabbit® 3000 at 29.4 MHz
Flash Memory 512K 256K
SRAM 512K 256K

Connection for user-supplied backup battery

Backup Battery (to support RTC and SRAM)

8 channels single-ended or 4 channels differential

Analog Input ;
nalog nputs Programmable gain 1, 2, 4, 5, 8, 10, 16, and 20 V/V

o A/D Converter

. 12 bits (11 bits single-ended)
Resolution

e A/D Conversion Time
(including 120 ps raw 180 ps
count and Dynamic C)

47 parallel digital 1/0 lines:
« 41 configurable 1/0
« 3 fixed inputs
« 3 fixed outputs

General-Purpose 1/0

Additional Inputs Startup mode (2), reset in, CONVERT

Additional Outputs Status, reset out, VREF

Can be configured for 8 data lines and

Auxiliary 1/O Bus 6 address lines (shared with parallel 1/O lines), plus 1/0 read/write

5 shared high-speed, CMOS-compatible ports:
® all 5 configurable as asynchronous, 3 as clocked serial (SPI), and 2

Serial Ports as SDLC/HDLC
® 1 asynchronous serial port dedicated for programming
® Support for MIR/SIR IrDA transceiver

Serial Rate Maximum asynchronous baud rate = CLK/8

A slave port allows the RCM3400 to be used as an intelligent
Slave Interface peripheral device slaved to a master processor, which may either be
another Rabbit 3000 or any other type of processor

Real-Time Clock Yes
. Ten 8-bit timers (6 cascadable), one 10-bit timer with 2 match
Timers .
registers
Watchdog/Supervisor Yes
Pulse-Width Modulators 10-bit free-running counter and four pulse-width registers
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Table A-1.

RabbitCore RCM3400 Specifications (continued)

Parameter

RCM3400 RCM3410

Input Capture

2-channel input capture can be used to time input signals from various
port pins

Quadrature Decoder

2-channel quadrature decoder accepts inputs from external
incremental encoder modules

Power

3.0-3.45V DC @ 29.4 MHz, 2.8-3.45V DC @ 14.7 MHz
97 mA @ 3.3V, 29.4 MHz; 57 mA @ 3.0V, 14.7 MHz

Operating Temperature

—40°C to +85°C

Humidity 5% to 95%, noncondensing
Connectors Two 2 x 17, 1.27 mm pitch
Board Size 1.160" x 1.375" x 0.31

(29.5 mm x34.9 mm x 7.9 mm)

User’s Manual

61



A.1.1 Headers

The RCM3400 uses headers at J1 and J2 for physical connection to other boards. J1 and J2
are 2 x 17 SMT headers with a 1.27 mm pin spacing.

Figure A-3 shows the layout of another board for the RCM3400 to be plugged into. These
values are relative to the designated fiducial.

'0.050
(1.3)

J1 RCM3400 Footprint

0.900
(22.9)

0.046

(1.2)

Figure A-3. User Board Footprint for RCM3400
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A.2 Bus Loading

You must pay careful attention to bus loading when designing an interface to the
RCM3400. This section provides bus loading information for external devices.

Table A-2 lists the capacitance for the various RCM3400 1/O ports.

Table A-2. Capacitance of Rabbit 3000 I/O Ports

Input Output
I/O Ports Capacitance Capacitance
(PF) (PF)
Parallel Ports A to G 12 14

Table A-3 lists the external capacitive bus loading for the various RCM3400 output ports.

Be sure to add the loads for the devices you are using in your custom system and verify
that they do not exceed the values in Table A-3.

Table A-3. External Capacitive Bus Loading -40°C to +85°C

Output Port Clock Speed Maximum External
i (MHz2) Capacitive Loading (pF)

All 1/0 lines with clock
doubler enabled 294 0

All I/O lines with clock
doubler disabled 14.7456 100

Table A-4 lists the loadings for the A/D converter inputs.

Table A-4. A/D Converter Inputs

Parameter Value

Input Capacitance 4-9.7 pF

Common-Mode 6 MQ

Input Impedance Differential 7 MQ
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Figure A-4 shows a typical timing diagram for the Rabbit 3000 microprocessor external
1/0 read and write cycles.

External I/O Read (one programmed wait state)
1 | Tw——se—— T2 |
CLK —
A[15:0] X valid X
7 Tadr
/CSx | | \__
< Tesx Tesx| <7
/I0CSx K -
1 Tiocsx Tiocsx|< ]
/IORD -
TiorD TiorRD[<]
/BUFEN -
“1TBUFEN TBUFﬁN‘_’
setup, |
D[7:0] < X valid -
| Thold <"
External I/O Write (one programmed wait state)
k—T1 | Tw—] T2 ——)
o | | |
A[15:0] — X valid : C
7 Tadr ‘
\
ICSx | 1 \ N
I Tcsx } Tesx[7
/I0CSx ! ) &
“—1Tiocsx { Tiocsx[<|
/IOWR ‘
Tiowr TiowR[<™]
/BUFEN 8
~1TBUFEN TBUFEN
D[7:0] valid o
TbHzv ‘ TovHzZ <

Figure A-4. External I/0O Read and Write Cycles—No Extra Wait States

NOTE: /IOCSx can be programmed to be active low (default) or active high.
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Table A-5 lists the delays in gross memory access time for several values of Vpp.

Table A-5. Data and Clock Delays Vpp £#10%, Temp, -40°C—+85°C (maximum)

Clock to Address Output Delay Spectrum Spreader Delay
(ns) Data Setup (ns)
VDD Time Delay
30 oF 60 0F 90 oF (ns) Normal Strong
P P P dbl/no dbl | dbl/no dbl
3.3 6 8 11 1 3/4.5 4.5/9
2.8 7 10 13 1.5 3.5/5.5 5.5/11

The measurements are taken at the 50% points under the following conditions.

o T=-40°C t0 85°C, V = Vpp +10%

¢ Internal clock to nonloaded CLK pin delay <1 ns @ 85°C/3.0 V

The clock to address output delays are similar, and apply to the following delays.
e T4 the clock to address delay

o Tcsy the clock to memory chip select delay

* Tiocsx the clock to 1/0 chip select delay

* T,0rD, the clock to I/O read strobe delay

e T,owr the clock to I/0 write strobe delay

e Tguren, the clock to I/O buffer enable delay

The data setup time delays are similar for both Tgey,n and Tpoyg.

When the spectrum spreader is enabled with the clock doubler, every other clock cycle is
shortened (sometimes lengthened) by a maximum amount given in the table above. The
shortening takes place by shortening the high part of the clock. If the doubler is not
enabled, then every clock is shortened during the low part of the clock period. The maxi-
mum shortening for a pair of clocks combined is shown in the table.

Technical Note TN227, Interfacing External 1/0 with Rabbit 2000/3000 Designs, con-
tains suggestions for interfacing 1/0 devices to the Rabbit 3000 microprocessors.
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A.3 Rabbit 3000 DC Characteristics

Table A-6. Rabbit 3000 Absolute Maximum Ratings

Symbol Parameter Maximum Rating
Ta Operating Temperature -55° to +85°C
Ts Storage Temperature -65° to +150°C

Maximum Input Voltage:

® Oscillator Buffer Input Vpp +05V

e 5-V-tolerant I/O 55V
Vpp | Maximum Operating Voltage 3.6V

Stresses beyond those listed in Table A-6 may cause permanent damage. The ratings are
stress ratings only, and functional operation of the Rabbit 3000 chip at these or any other
conditions beyond those indicated in this section is not implied. Exposure to the absolute
maximum rating conditions for extended periods may affect the reliability of the Rabbit
3000 chip.

Table A-7 outlines the DC characteristics for the Rabbit 3000 at 3.3 V over the recom-
mended operating temperature range from T, = -55°C to +85°C, Vpp =3.0V t0 3.6 V.

Table A-7. 3.3 Volt DC Characteristics

Symbol Parameter Test Conditions Min | Typ | Max | Units
Vpop | Supply Voltage 3.0 3.3 3.6 \Y
Vig | High-Level Input Voltage 2.0 \Y
VL Low-Level Input Voltage 0.8 \Y

IOH =6.8 mA, 0.7 x
V igh- .
oH | High-Level Output Voltage Vpp = Vpp (Min) Voo \%
Vv Low-Level Output Volt lo, =6.8mA, 04 | Vv
oL ow-Level Output Voltage Vpp = Vpp (Min) .
| High-Level Input Current | ViN = VDD 10 A
'H | (@bsolute worst case, all buffers) | Vpp = Vpp (Mmax) H
| Low-Level Input Current | VIN = Vss, 10 A
IL (absolute worst case, all buffers) | Vpp = Vpp (max) H
High-Impedance State Vin = Vpp OF Vss,
loz Output Current Vpp = Vpp (Max), no pull-u -10 10 HA
(absolute worst case, all buffers) | ~ PP~ *DD » N0 puli-up
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A.4 1/0O Buffer Sourcing and Sinking Limit

Unless otherwise specified, the Rabbit 1/0 buffers are capable of sourcing and sinking
6.8 mA of current per pin at full AC switching speed. Full AC switching assumes a
29.4 MHz CPU clock and capacitive loading on address and data lines of less than 70 pF
per pin. The absolute maximum operating voltage on all 1/0 is 5.5 V.

Table A-8 shows the AC and DC output drive limits of the parallel 1/0 buffers when the
Rabbit 3000 is used in the RCM3400.

Table A-8. I/O Buffer Sourcing and Sinking Capability

Output Drive (Full AC Switching)

Sourcing/Sinking Limits

Pin Name (MA)
Sourcing Sinking
All data, address, and 1/0
lines with clock doubler 6.8 6.8
enabled

Under certain conditions, the maximum instantaneous AC/DC sourcing or sinking current
may be greater than the limits outlined in Table A-8. The maximum AC/DC sourcing cur-
rent can be as high as 12.5 mA per buffer as long as the number of sourcing buffers does
not exceed three per Vpp or Vgg pad, or up to six outputs between pads. Similarly, the
maximum AC/DC sinking current can be as high as 8.5 mA per buffer as long as the num-
ber of sinking buffers does not exceed three per Vpp or Vgg pad, or up to six outputs
between pads. The Vpp bus can handle up to 35 mA, and the Vgg bus can handle up to
28 mA. All these analyses were measured at 100°C.
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A.5 Conformal Coating

The areas around the 32 kHz real-time clock crystal oscillator have had the Dow Corning
silicone-based 1-2620 conformal coating applied. The conformally coated area is shown
in Figure A-5. The conformal coating protects these high-impedance circuits from the
effects of moisture and contaminants over time.

|-| RPZ__RP3 _RPA_ JP3 % )
= L e
88 S 0 Conformally coated
go | area
ot EY
55/
d BS
1l
B
5
EE3
B
R1 O

Figure A-5. RCM3400 Areas Receiving Conformal Coating

Any components in the conformally coated area may be replaced using standard soldering
procedures for surface-mounted components. A new conformal coating should then be
applied to offer continuing protection against the effects of moisture and contaminants.

NOTE: For more information on conformal coatings, refer to Technical Note 303, Con-
formal Coatings.
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A.6 Jumper Configurations

Figure A-6 shows the header locations used to configure the various RCM3400 options
via jumpers.

— N H
XN Top Side |:|JP3

.

Figure A-6. Location of RCM3400 Configurable Positions

Table A-9 lists the configuration options.

Table A-9. RCM3400 Jumper Configurations

Header Description Pins Connected Factory
Default

1-2 | 128K/256K RCM3410
JP1 Flash Memory Size

2-3 | 512K RCM3400

1-2 | Normal Mode X
JP2 Flash Memory Bank Select

2-3 |Bank Mode

1-2 | 128K/256K RCM3410
JP3 | SRAM Size

2-3 | 512K RCM3400

NOTE: The jumper connections are made using 0 Q surface-mounted resistors.
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APPENDIX B. PROTOTYPING BOARD

Appendix B describes the features and accessories of the Proto-
typing Board, and explains the use of the Prototyping Board to
demonstrate the RCM3400 and to build prototypes of your own
circuits. The RCM3400 Prototyping Board has power-supply
connections and also provides some basic 1/O peripherals
(RS-232, RS-485, A/D converter screw-terminal header, IrDA
transceiver, LEDs, and switches), as well as a prototyping area
for more advanced hardware development.
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B.1 Introduction

The Prototyping Board included in the Development Kit makes it easy to connect an

RCM3400 module to a power supply and a PC workstation for development. It also pro-
vides some basic 1/0 peripherals (RS-232, RS-485, an IrDA transceiver, an Ethernet port,
LEDs, and switches), as well as a prototyping area for more advanced hardware develop-
ment.

For the most basic level of evaluation and development, the Prototyping Board can be

used without modification.

As you progress to more sophisticated experimentation and hardware development,
modifications and additions can be made to the board without modifying the RCM3400
module.

The Prototyping Board is shown below in Figure B-1, with its main features identified.

ge_?e; Current-
RCM3400 W' Rs232  Ry45 Measurement Flower
Programming RS-485 Headers Ethernet Ethernet
RCM3400 Module ~ Header Jack LEDs Power
Extension Header LED

RCM3400
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Connectors\
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Transceiver
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Q0000000000000000000000000
Q0000000000000 000Q00QVVQOK
38 Thvough Holo SSR00853
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5[000000000
21000000000
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060000000
000000000 -
000000000 |
00000000!

000 Prototyping Area 1900000000

O
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LCD/Keypad
Analog User Module
Inputs LEDs User Connections
Switches

Figure B-1. Prototyping Board
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B.1.1 Prototyping Board Features

Power Connection—A power-supply jack and a 3-pin header are provided for con-
nection to the power supply. Note that the 3-pin header is symmetrical, with both outer
pins connected to ground and the center pin connected to the raw V+ input. The cable
of the AC adapter provided with the North American version of the Development Kit is
terminated with a 5.5 mm plug that connects to the power-supply jack. The header plug
leading to bare leads provided for overseas customers can be connected to the 3-pin
header in either orientation.

Users providing their own power supply should ensure that it delivers 8-24 V DC at
8 W. The voltage regulators will get warm while in use.

Regulated Power Supply—The raw DC voltage provided at the POWER IN jack is
routed to a 5 V switching voltage regulator, then to a separate 3.3 V linear regulator.
The regulators provide stable power to the RCM3400 module and the Prototyping
Board.

Power LED—The power LED lights whenever power is connected to the Prototyping
Board.

Reset Switch—A momentary-contact, normally open switch is connected directly to the
RCM3400’s /RESET_IN pin. Pressing the switch forces a hardware reset of the system.

Programming Header—The programming cable is used to connect the RCM3400 via
the programming header on the Prototyping Board to your PC to enable you to program
your RCM3400 module.

I/O Switches and LEDs—Two momentary-contact, normally open switches are con-
nected to the PD4 and PD5 pins of the RCM3400 module and may be read as inputs by
sample applications.

Two LEDs are connected to the PD6 and PD7 pins of the RCM3400 module, and may
be driven as output indicators by sample applications.

Prototyping Area—A generous prototyping area has been provided for the installation
of through-hole components. +3.3 V, +5 V, and Ground buses run around the edge of
this area. Several areas for surface-mount devices are also available. (Note that there
are SMT device pads on both top and bottom of the Prototyping Board.) Each SMT pad
is connected to a hole designed to accept a 30 AWG solid wire.

Module Extension Headers—The complete non-analog pin set of the RCM3400
module is duplicated at header J1. Developers can solder wires directly into the appro-
priate holes, or, for more flexible development, a 2 x 30 header strip with a 0.1" pitch
can be soldered into place. See Figure B-4 for the header pinouts.

Analog Inputs Screw-Terminal Header—The complete analog pin set of the
RCM3400 module is duplicated at screw-terminal header J3. See Figure B-4 for the
header pinouts.

Ethernet—One 10/100Base-T Ethernet port is available on the Prototyping Board with
an RJ-45 jack at J7. LNK and ACT LEDs indicate a live Ethernet link and Ethernet
activity.
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RS-232—Two 3-wire or one 5-wire RS-232 serial ports are available on the Prototyp-
ing Board at header J5 and another two 3-wire or one 5-wire RS-232 serial ports are
available at header J6.

A 10-pin 0.1-inch spacing header strip is installed at J5 allows you to connect a ribbon
cable that leads to a standard DE-9 serial connector.

NOTE: An RS-232 driver chip needs to be installed at U5 along with a header at J6 and
filtering capacitors in order to use header J6.

RS-485—O0ne RS-485 serial port is available on the Prototyping Board at screw-termi-
nal header J4. Jumpers on header JP3 configure the termination and bias resistors.

Current Measurement Option—Jumpers across pins 1-2 and 5-6 on header JP10 can
be removed and replaced with an ammeter across the pins to measure the current drawn
from the +5 V or the +3.3 V supplies, respectively.

LCD/Keypad Module—Rabbit Semiconductor’s LCD/keypad module may be plugged
in directly to headers LCD1JA, LCD1JB, and LCD1JC. Appendix D provides complete
information for mounting and using the LCD/keypad module.

IrDA—An infrared transceiver on the Prototyping Board is capable of handling link
distances up to 1.5 m. The infrared transceiver uses Serial Port F.

Backup Battery—A 2032 lithium-ion battery rated at 3.0 V, 220 mA:h, provides
battery backup for the RCM3400 SRAM and real-time clock.
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B.2 Mechanical Dimensions and Layout

Figure B-2 shows the mechanical dimensions and layout for the RCM3400 Prototyping Board.
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Figure B-2. Prototyping Board Dimensions
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Table B-1 lists the electrical, mechanical, and environmental specifications for the Proto-
typing Board.

Table B-1. Prototyping Board Specifications

Parameter Specification
Board Size 4.80" x 6.70" x 0.98" (122 mm x 170 mm x 25 mm)
Ethernet Port 10/100Base-T, RJ-45, 2 LEDs
Operating Temperature —20°C to +60°C
Humidity 5% to 95%, noncondensing
Input Voltage 8Vto24VDC
Maximum Current Draw 800 mA max. for +3.3 V supply,

(including user-added circuits) | 1 A total +3.3 V and +5 V combined

2" x 4" (50 mm x 100 mm) throughhole, 0.1" spacing, additional

Prototyping Area space for SMT components

Two 2 x 17 header sockets, 1.27 mm pitch, to accept RCM3400
One 2 x 5 IDC programming header, 1.27 mm pitch

Connectors One 2 x 5 IDC RS-232 header, 0.1" pitch

Two screw-terminal headers for RS-485 signals and analog inputs
Two unstuffed header locations for RS-232 and RCM3400 signals

Standoffs/Spacers 6, accept 4-40 x Y2 screws

B.3 Power Supply

The RCM3400 requires a regulated 2.8 VV — 3.45 VV DC power source to operate. Depend-
ing on the amount of current required by the application, different regulators can be used
to supply this voltage.

The Prototyping Board has an onboard +5 V switching power regulator from which a
+3.3 V linear regulator draws its supply. Thus both +5 V and +3.3 V are available on the
Prototyping Board.

The Prototyping Board itself is protected against reverse polarity by a Shottky diode at D2
as shown in Figure B-3.

LINEAR POWER

18109 SWITCHING POWER REGULATOR  +5V REGULATOR 5 5y
e U LM1117
W_ [ ]+raw P2 DCIN I s[ Uto |
== Pl * u12
e bk DL4G03 | G 1 1

I47 uF oL I‘IO uF - I‘10 uF

= LM2575 L1 =
= D1 = =
L L X issre

Figure B-3. Prototyping Board Power Supply
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B.4 Using the Prototyping Board

The Prototyping Board is actually both a demonstration board and a prototyping board.
As a demonstration board, it can be used to demonstrate the functionality of the RCM3400
right out of the box without any modifications to either board.

The Prototyping Board comes with the basic components necessary to demonstrate the
operation of the RCM3400. Two LEDs (DS1 and DS2) are connected to PD6 and PD?7,
and two switches (S2 and S3) are connected to PD4 and PD5 to demonstrate the interface
to the Rabbit 3000 microprocessor. Reset switch S1 is the hardware reset for the RCM3400.

The Prototyping Board provides the user with RCM3400 connection points brought out con-
veniently to labeled points at header J1 and J3 on the Prototyping Board. Although header J1
is unstuffed, a 2 x 30 header is included in the bag of parts. RS-485 signals are available on
header J4, and RS-232 signals are available on header J5 (Serial Ports C and D) and header
J6 (Serial Ports E and F). A header strip at J5 allows you to connect a ribbon cable, anda 2 x 5
header is included in the bag of parts for optional installation at J6. The pinouts for these
locations are shown in Figure B-4.
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CONVERT
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Inputs

Figure B-4. Prototyping Board Pinout
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Selected signals from the Rabbit 3000 microprocessor are available on header J1 of the
Prototyping Board. The remaining ports on the Rabbit 3000 microprocessor are used for
RS-232, RS-485, and Ethernet serial communication. Table B-2 lists the signals on header
J1 and explains how they are used on the Prototyping Board.

Table B-2. Use of Rabbit 3000 Signals on RCM3400 Prototyping Board

Pin Pin Name Prototyping Board Use
1-8 PAO-PA7 | External I/O data, IDO-1D7
9 PB1 Programming port CLKA
10-15 PB2-PB7 | External I/O address, IAO-1A5
16-17 PCO-PC1 | Serial Port D (RS-232, header J5)
18-19 PC2-PC3 | Serial Port C (RS-232, header J5)
20-21 PC6-PC7 | Serial Port A (programming port)
22 /IORD External read strobe
23 /IOWR External write strobe
24 STATUS | Output
25 SMODE1 .
Programming port
26 SMODEO
27 PDO RS-485 transmit enable
28 PD4 Switch S3 (normally open/pulled up)
29 PD5 Switch S2 (normally open/pulled up)
30 PD6 LED DS1 (normally high/off)
31 PD7 LED DS2 (normally high/off)
32 PEO Ethernet
33 PE1 Input (pulled up)
34 PE2 Ethernet
35 PE4 IrDA
36 PES Input (pulled up)
37 PEG6 External 1/O strobe, LCD/keypad module
38 PE7 Input (pulled up)
39-40 PFO-PF1 | Input (pulled up)
41-44 PF4-PF7 | Input (pulled up)
45 PGO Input (pulled up)
46 PG1 Ethernet
47-48 PG2-PG3 | Serial Port F (RS-232/1rDA)
49-50 PG4-PG5 | IrDA inputs
51-52 PG6-PG7 | Serial Port E (RS-485/RS-232)
53 /RES_OUT | Reset output from Reset Generator
54 /RESET _IN | Input to Reset Generator
55 +3.3V
56 GND
57 VBAT
58 +3.3V
59-60 GND
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There isa 2" x 4" through-hole prototyping space available on the Prototyping Board. The
holes in the prototyping area are spaced at 0.1" (2.5 mm). +3.3 V, +5 V, and GND traces run
along the edge of the Prototyping Board for easy access. Small to medium circuits can be
prototyped using point-to-point wiring with 20 to 30 AWG wire between the prototyping
area, the +3.3 'V, +5 V, and GND traces, and the surrounding area where surface-mount
components may be installed. Small holes are provided around the surface-mounted com-
ponents that may be installed around the prototyping area.

B.4.1 Adding Other Components

There are two sets of pads for 28-pin devices that can be used for surface-mount prototyp-
ing involving SOIC devices.There are also pads that can be used for SMT resistors and
capacitors in an 0805 SMT package. Each component has every one of its pin pads con-
nected to a hole in which a 30 AWG wire can be soldered (standard wire wrap wire can be
soldered in for point-to-point wiring on the Prototyping Board). Because the traces are
very thin, carefully determine which set of holes is connected to which surface-mount pad.

B.4.2 Measuring Current Draw

The Prototyping Board has a current-measurement feature available on header JP10. Nor-
mally, a jumper connects pins 1-2 and pins 5-6 on header JP10, which provide jumper
connections for the +5 V and the +3.3 V regulated voltages respectively. You may remove
a jumper and place an ammeter across the pins instead, as shown in the example in
Figure B-5, to measure the current being drawn.
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Figure B-5. Prototyping Board Current-Measurement Option
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B.4.3 Analog Features

The Prototyping Board has typical support circuitry installed to complement the ADS7870
A/D converter on the RCM3400 module.

B.4.3.1 A/D Converter Inputs

Figure B-6 shows a pair of A/D converter input circuits. The resistors form an approx.
10:1 attenuator, and the capacitor filters noise pulses from the A/D converter input.

+V

178 kQ
ADC_INO

AN ADC
ADC_IN1 J\/\/\/ _ _ —

178 kQ
1 nEL1 nF §

P1 -
1 I J BVREF =

2.048V

20 kQ
20 kQ

0Q

AGND Fa C- tory
Default

e

Figure B-6. A/D Converter Inputs

The A/D converter chip can make either single-ended or differential measurements
depending on the value of the opmode parameter in the software function call. Adjacent
A/D converter inputs are paired to make differential measurements. The default setup on
the Prototyping Board is to measure only positive voltages for the ranges listed in Table B-3.

Table B-3. Positive A/D Converter Input Voltage Ranges

i Amplifier
Min. X;))Itage Max.(\\//t;ltage Gr;in e mV per Tick
0.0 +20.0 1 10
0.0 +10.0 2 5
0.0 +5.0 4 25
0.0 +4.0 5 2.0
0.0 +2.5 8 1.25
0.0 +2.0 10 1.0
0.0 +1.25 16 0.625
0.0 +1.0 20 0.500
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Many other possible ranges are possible by physically changing the resistor values that
make up the attenuator circuit.

It is also possible to read a negative voltage on ADC_INO-ADC_IN5 by moving the 0 Q
jumper (see Figure B-6) on header JP1, JP2, or JP9 associated with the A/D converter
input from analog ground to the reference voltage generated and buffered by the A/D con-
verter. Adjacent input channels are paired so that moving a particular jumper changes both
of the paired channels. At the present time Rabbit Semiconductor does not offer the soft-
ware drivers to work with single-ended negative voltages, but the differential mode
described below may be used to measure negative voltages.

NOTE: THERM_IN7 was configured to illustrate the use of a thermistor with the sample
program, and so is not available for use as a differential input. There is also no resistor
attenuator for THERM _IN7, so its input voltage range is limited.

Differential measurements require two channels. As the name differential implies, the dif-
ference in voltage between the two adjacent channels is measured rather than the differ-
ence between the input and analog ground. Voltage measurements taken in differential
mode have a resolution of 12 bits, with the 12th bit indicating whether the difference is
positive or negative.

The A/D converter chip can only accept positive voltages, as explained in Section 4.4. Both
differential inputs must be referenced to analog ground, and both inputs must be positive
with respect to analog ground. Table B-4 provides the differential voltage ranges for this
setup.

Table B-4. Differential Voltage Ranges

Min. Differential | Max. Differential Amplifier _
Voltage Voltage : mV per Tick

V) V) Gain
0 +20.0 x1 10
0 +10.0 x2 5
0 +5.0 x4 25
0 +4.0 x5 2.0
0 2.5 x8 1.25
0 +2.0 x10 1.00
0 +1.25 x16 0.625
0 +1.0 x20 0.500

The A/D converter inputs can also be used with 4-20 mA current sources by measuring the
resulting analog voltage drop across 249 Q 1% precision resistors placed between the ana-
log input and analog ground for ADC_IN3 to ADC_ING6. Be sure to reconfigure the
jumper positions on header JP5 as shown in Section B.5 using the slip-on jumpers
included with the spare parts in the Development Kit.
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B.4.3.2 Thermistor Input

Analog input THERM_IN7 on the Prototyping Board was designed specifically for use
with a thermistor in conjunction with the THERMISTOR . ¢ sample program, which demon-
strates how to use analog input THERM _IN7 to calculate temperature for display to the
Dynamic C STDIO window. The sample program is targeted specifically for the thermistor
included with the Development Kit with Ry @ 25°C = 3 kQ and 3 25/85 = 3965. Be sure

to use the applicable Ry and 3 values for your thermistor if you use another thermistor.

Thermistor

J3

THERM_IN7

BVREF

1kQ

®
ANALOG_GND

=

ADC

Figure B-7. Prototyping Board Thermistor Input
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B.4.3.3 A/D Converter Calibration

All single-ended inputs are factory-calibrated with actual voltages at a gain code of 0.
Typical values for the other gain codes and for other calibration constants for current and
differential measurements are used to populate the table to allow A/D conversions to be
done “out of the box.” To get the best results form the A/D converter, it is necessary to
calibrate each mode (single-ended, differential, and current) for each of its gains. It is
imperative that you calibrate each of the A/D converter inputs in the same manner as they
are to be used in the application. For example, if you will be performing floating differen-
tial measurements or differential measurements using a common analog ground, then cali-
brate the A/D converter in the corresponding manner. The calibration must be done with
the attenuator reference selection jumper in the desired position (see Figure B-6). If a cali-
bration is performed and the jumper is subsequently moved, the corresponding input(s)
must be recalibrated. The calibration table in software only holds calibration constants
based on mode, channel, and gain. Other factors affecting the calibration must be taken
into account by calibrating using the same mode and gain setup as in the intended use.

Sample programs are provided to illustrate how to read and calibrate the various A/D
inputs for the three operating modes.

Mode Read Calibrate
Single-Ended, one channel - AD CAL CHAN.C
Single-Ended, all channels AD RDVOLT ALL.C AD CAL ALL.C
Milli-Amp, one channel AD RDMA CH.C AD CALMA CH.C
Differential, analog ground AD RDDIFF CH.C AD CALDIFF CH.C

These sample programs are found in the SAMPLES\RCM3400\ADC subdirectory. See
Section 3.2.2 for more information on these sample programs and how to use them.
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B.4.4 Serial Communication

The RCM3400 Prototyping Board allows you to access five of the serial ports from the
RCM3400 module. Table B-5 summarizes the configuration options. Note that Serial
Ports E and F can be used only with the RCM3400 Prototyping Board.

Table B-5. Prototyping Board Serial Port Configurations

Serial Port Header Default Use Alternate Use
A J2 Programming Port RS-232
C J5 RS-232 —
D J5 RS-232 —
E 4, 36 RS-485 (J4) RS-232 (J6)
F IrDA, J6 IrDA Transceiver RS-232 (J6)

Serial Port E is configured in hardware for RS-232 or RS-485 via jumpers on headers JP4
and JP8 as shown in Section B.5. Serial Port F is configured in hardware for the IrDA
transceiver or RS-232 via jumpers on headers JP6 and JP7 as shown in Section B.5.
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B.4.4.1 RS-232

RS-232 serial communication on header J5 on both Prototyping Boards is supported by an
RS-232 transceiver installed at U4. This transceiver provides the voltage output, slew rate,
and input voltage immunity required to meet the RS-232 serial communication protocol.
Basically, the chip translates the Rabbit 3000’s signals to RS-232 signal levels. Note that
the polarity is reversed in an RS-232 circuit so that a +5 V output becomes approximately
-10 V and 0 V is output as +10 V. The RS-232 transceiver also provides the proper line
loading for reliable communication.

A customer-supplied RS-232 transceiver may be installed at U5 on the RCM3400 Proto-
typing Board, and a 2 x 5 header from the bag of parts in the RCM3400 Development Kit
may be installed at J6 to access Serial Ports E and F, which are by default configured for
RS-485 and IrDA support on the RCM3400 Prototyping Board. Be sure to configure the
0 Q jumpers as explained in Section B.5 to be able to access Serial Ports E and F on
header J6.

RS-232 can be used effectively at the RCM3400 module’s maximum baud rate for distances
of upto 15 m.

RS-232 flow control on an RS-232 port is initiated in software using the serxflowcon-
trolon function call from Rs232.LIB, where X is the serial port (C or D). The locations
of the flow control lines are specified using a set of five macros.

SERX RTS PORT—Data register for the parallel port that the RTS line is on (e.g., PCDR).

SERA RTS SHADOW—Shadow register for the RTS line's parallel port (e.g., PCDRShadow).
SERA_ RTS_ BIT—The bit number for the RTS line.

SERA CTS_ PORT—Data register for the parallel port that the CTS line is on (e.g., PCDRShadow).
SERA_CTS_BIT—The bit number for the CTS line.

Standard 3-wire RS-232 communication using Serial Ports C and D is illustrated in the
following sample code.

#define CINBUFSIZE 15
#define COUTBUFSIZE 15

#define DINBUFSIZE 15
#define DOUTBUFSIZE 15

#ifndef _232BAUD
#define 232BAUD 115200
#endif

main () {
serCopen ( 232BAUD) ;
serDopen (_232BAUD) ;
serCwrFlush() ;
serCrdFlush() ;
serDwrFlush() ;
serDrdFlush() ;
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B.4.4.2 RS-485

The RCM3400 Prototyping Board has one RS-485 serial channel, which is connected to
the Rabbit 3000 Serial Port E through an RS-485 transceiver. The half-duplex communi-
cation uses an output from PDO on the Rabbit 3000 to control the transmit enable on the
communication line. Using this scheme a strict master/slave relationship must exist
between devices to insure that no two devices attempt to drive the bus simultaneously.

Serial Port E is configured in software for RS-485 as follows.

#define ser485open serEopen
#define ser485close serEclose
#define ser485wrFlush serEwrFlush
#define ser485rdFlush serErdFlush
#define ser485putc serEputc
#define ser485getc serEgetc

#define EINBUFSIZE 15
#define EOUTBUFSIZE 15

#ifndef 485BAUD

#define 485BAUD 115200

#endif
The configuration shown above is based on circular buffers. RS-485 configuration may
also be done using functions from the pPACKET . LIB library.

The RCM3400 Prototyping Boards with RCM3400 modules installed can be used in an
RS-485 multidrop network spanning up to 1200 m (4000 ft), and there can be as many as
32 attached devices. Connect the 485+ to 485+ and 485 to 485- using single twisted-pair
wires as shown in Figure B-8. Note that a common ground is recommended.

/}fs:cs:ﬁ&:cx::S::&.'\ 'ﬁ=c>:<>:<>=s=<>a?

| + N | + N | + N
v Y = 0 v = v Y =
230 P30 P30
L L r o

Figure B-8. RCM3400 Multidrop Network
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The RCM3400 Prototyping Board comes with a 220 Q termination resistor and two 681 Q

bias resistors installed and enabled with jumpers across pins 1-2 and 5-6 on header JP3,

as shown in Figure B-9.
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Figure B-9. RS-485 Termination and Bias Resistors

For best performance, the termination resistors in a multidrop network should be enabled
only on the end nodes of the network, but not on the intervening nodes. Jumpers on boards

whose termination resistors are not enabled may be stored across pins 1-3 and 4-6 of

header JP3.
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B.4.4.3 Ethernet Port

Figure B-10 shows the pinout for the Ethernet port (header J7). Note that there are two stan-
dards for numbering the pins on this connector—the convention used here, and numbering
in reverse to that shown. Regardless of the numbering convention followed, the pin posi-
tions relative to the spring tab position (located at the bottom of the RJ-45 jack in

Figure B-10) are always absolute, and the RJ-45 connector will work properly with off-
the-shelf Ethernet cables.

ETHERNET
' | @ |
1. E_Tx+
2. E_Tx—
3. E_Rx+
6. E_Rx—
RJ-45 Plug RJ-45 Jack

Figure B-10. RJ-45 Ethernet Port Pinout

RJ-45 pinouts are sometimes numbered opposite to the way shown in Figure B-10.

Two LEDs are placed next to the RJ-45 Ethernet jack, one to indicate a live Ethernet link
(LNK) and one to indicate Ethernet activity (ACT).

The transformer/connector assembly ground is connected to the RCM3400 Prototyping
Board printed circuit board digital ground via a 0 Q resistor “jumper,” R46, as shown in
Figure B-11.

RJ-45 Ethernet Plug

R46

Board Chassis
Ground = = Ground

Figure B-11. Isolation Resistor R46

The factory default is for the 0 Q resistor “jumper” at R46 to be installed. In high-noise
environments, remove R46 and ground the transformer/connector assembly directly to
ground by soldering a wire between the RJ-45 transformer/connector assembly and
ground. This will be especially helpful to minimize ESD and/or EMI problems.
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B.4.5 Other Prototyping Board Modules

An optional LCD/keypad module is available that can be mounted on the RCM3400
Prototyping Board. Refer to Appendix D, “LCD/Keypad Module,” for complete
information.
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B.5 RCM3400 Prototyping Board Jumper Configurations

Figure B-12 shows the header locations used to configure the various RCM3400 Prototyp-
ing Board options via jumpers.
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JP3 OQ)
00 OO
otele O

=5
u JP4

Note

n JPe JP6 and JP7 are located
u JP7 under the RCM3400
(if the RCM3400 module

JP5

8550

CITICCOICE
| | |
JP1 JP2 JP9

is plugged in)

Figure B-12. Location of Configurable Jumpers on RCM3400 Prototyping Board

Table B-6 lists the configuration options using either jumpers or 0 Q surface-mount resistors.

Table B-6. RCM3400 Prototyping Board Jumper Configurations

Header Description Pins Connected ISl
Default
1-2 | Tied to VREF
JP1 ADC_INO-ADC_IN1
2-3 | Tied to analog ground X
1-2 | Tied to VREF
JP2 ADC_IN2-ADC _IN3
2-3 | Tied to analog ground X

90

RabbitCore RCM3400




Table B-6. RCM3400 Prototyping Board Jumper Configurations (continued)

Header Description Pins Connected Factory
Default
1-2 | Connect for 4-20 mA option on ADC_IN3 n.c.
Analog Voltage/4—20 mA 3-4 | Connect for 4-20 mA option on ADC_IN4 n.c.
JP5 .
Options 5-6 | Connect for 4-20 mA option on ADC_IN5 n.c.
7-8 | Connect for 4-20 mA option on ADC_IN6 n.c.
1-2 | Tied to VREF
JP9 | ADC_IN4-ADC_IN5
2-3 | Tied to analog ground X
1-2 |45V Connected
JP10 | Current Measurement Option
56 |+3.3V Connected
1-2 | Bias and termination resistors %
5-6 | connected
1P3 RS-485 Bias and Termination
Resistors 1-3 Bias and termination resistors not B
46 connected (parking position for 3
jumpers) =
c
S
1-2 | RS-485 X =
JP4* | PG7 RS-232/RS-485 Select S
2-3 | RS-232 (RXE) o
3
1-2 | IrDA X s
Jpe™ | PG3 IrDA/RS-232 Select @
2-3 | RS-232 (RxF) s
>
1-2 |IrDA X s
JP7" | PG2 IrDA/RS-232 Select 2
2-3 | RS-232 (TxF) Tf;
=
1-2 | RS-485 x | <
JP8* | PG6 RS-232/RS-485 Select
2-3 |RS-232 (TxE)

* These jumper connections are made using 0 Q surface-mounted resistors.
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APPENDIX C. USING THE TCP/IP
FEATURES

C.1 TCP/IP Connections

Programming and development can be done with the RCM3400 modules without connect-
ing the Ethernet port on the RCM3400 Prototyping Board to a network. However, if you
will be running the sample programs that use the Ethernet capability or will be doing
Ethernet-enabled development, you should connect the RCM3400 Prototyping Board’s
Ethernet port at this time.

Before proceeding you will need to have the following items.

¢ If you don’t have Ethernet access, you will need at least a 10Base-T Ethernet card
(available from your favorite computer supplier) installed in a PC.

e Two RJ-45 straight through Ethernet cables and a hub, or an RJ-45 crossover Ethernet
cable.

The Ethernet cables and a 10Base-T Ethernet hub are available from Rabbit Semiconduc-
tor in a TCP/IP tool kit. More information is available at www.rabbit.com.

1. Connect the AC adapter and the programming cable as shown in Chapter 2, “Getting
Started.”

2. Ethernet Connections

There are four options for connecting the RCM3400 Prototyping Board to a network
for development and runtime purposes. The first two options permit total freedom of
action in selecting network addresses and use of the “network,” as no action can inter-
fere with other users. We recommend one of these options for initial development.

e No LAN — The simplest alternative for desktop development. Connect the RCM3400
Prototyping Board’s Ethernet port directly to the PC’s network interface card using an
RJ-45 crossover cable. A crossover cable is a special cable that flips some connections
between the two connectors and permits direct connection of two client systems. A
standard RJ-45 network cable will not work for this purpose.

e Micro-LAN — Another simple alternative for desktop development. Use a small
Ethernet 10Base-T hub and connect both the PC’s network interface card and the
RCM3400 Prototyping Board’s Ethernet port to it using standard network cables.
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3.

The following options require more care in address selection and testing actions, as
conflicts with other users, servers and systems can occur:

LAN — Connect the RCM3400 Prototyping Board’s Ethernet port to an existing LAN,
preferably one to which the development PC is already connected. You will need to
obtain IP addressing information from your network administrator.

WAN — The RCM3400 is capable of direct connection to the Internet and other Wide
Area Networks through the Prototyping Board, but exceptional care should be used
with IP address settings and all network-related programming and development. We
recommend that development and debugging be done on a local network before con-
necting a RabbitCore system to the Internet.

TIP: Checking and debugging the initial setup on a micro-LAN is recommended before
connecting the system to a LAN or WAN.

The PC running Dynamic C through the serial port on the RCM3400 Prototyping Board
does not need to be the PC with the Ethernet card.

Apply Power

Plug in the AC adapter. The RCM3400 module and Prototyping Board are now ready to
be used.
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C.2 TCP/IP Primer on IP Addresses

Obtaining IP addresses to interact over an existing, operating, network can involve a num-
ber of complications, and must usually be done with cooperation from your ISP and/or
network systems administrator. For this reason, it is suggested that the user begin instead
by using a direct connection between a PC and the RCM3400 using an Ethernet crossover
cable or a simple arrangement with a hub. (A crossover cable should not be confused with
regular straight through cables.)

In order to set up this direct connection, the user will have to use a PC without networking,
or disconnect a PC from the corporate network, or install a second Ethernet adapter and set
up a separate private network attached to the second Ethernet adapter. Disconnecting your
PC from the corporate network may be easy or nearly impossible, depending on how it is
set up. If your PC boots from the network or is dependent on the network for some or all
of its disks, then it probably should not be disconnected. If a second Ethernet adapter is
used, be aware that Windows TCP/IP will send messages to one adapter or the other,
depending on the IP address and the binding order in Microsoft products. Thus you should
have different ranges of IP addresses on your private network from those used on the cor-
porate network. If both networks service the same IP address, then Windows may send a
packet intended for your private network to the corporate network. A similar situation will
take place if you use a dial-up line to send a packet to the Internet. Windows may try to
send it via the local Ethernet network if it is also valid for that network.

The following IP addresses are set aside for local networks and are not allowed on the
Internet: 10.0.0.0 to 10.255.255.255, 172.16.0.0 to 172.31.255.255, and 192.168.0.0 to
192.168.255.255.

The RCM3400 Prototyping Board uses a 10Base-T type of Ethernet connection, which is
the most common scheme. The RJ-45 connectors are similar to U.S. style telephone con-
nectors, except they are larger and have 8 contacts.

An alternative to the direct connection using a crossover cable is a direct connection using
a hub. The hub relays packets received on any port to all of the ports on the hub. Hubs are
low in cost and are readily available. The RCM3400 Prototyping Board uses 10 Mbps
Ethernet, so the hub or Ethernet adapter must be either a 10 Mbps unit or a 10/100 unit that
adapts to 10 Mbps.

In a corporate setting where the Internet is brought in via a high-speed line, there are typi-
cally machines between the outside Internet and the internal network. These machines
include a combination of proxy servers and firewalls that filter and multiplex Internet traf-
fic. In the configuration below, the RCM3400 Prototyping Board could be given a fixed
address so any of the computers on the local network would be able to contact it. It may be
possible to configure the firewall or proxy server to allow hosts on the Internet to directly
contact the controller, but it would probably be easier to place the controller directly on
the external network outside of the firewall. This avoids some configuration complications
by sacrificing some security.
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If your system administrator can give you an Ethernet cable along with its IP address, the
netmask and the gateway address, then you may be able to run the sample programs with-
out having to setup a direct connection between your computer and the RCM3400. You
will also need the IP address of the nameserver, the name or IP address of your mail
server, and your domain name for some of the sample programs.
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C.2.1 IP Addresses Explained

IP (Internet Protocol) addresses are expressed as 4 decimal numbers separated by periods,
for example:

216.103.126.155
10.1.1.6

Each decimal number must be between 0 and 255. The total IP address is a 32-bit number
consisting of the 4 bytes expressed as shown above. A local network uses a group of adja-

cent IP addresses. There are always 2N IP addresses in a local network. The netmask (also
called subnet mask) determines how many IP addresses belong to the local network. The
netmask is also a 32-bit address expressed in the same form as the IP address. An example
netmask is:

255.255.255.0

This netmask has 8 zero bits in the least significant portion, and this means that 28
addresses are a part of the local network. Applied to the IP address above
(216.103.126.155), this netmask would indicate that the following IP addresses belong to
the local network:

216.103.126.0
216.103.126.1
216.103.126.2
etc.
216.103.126.254
216.103.126.255

The lowest and highest address are reserved for special purposes. The lowest address
(216.103.126.0) is used to identify the local network. The highest address
(216.103.126.255) is used as a broadcast address. Usually one other address is used for the
address of the gateway out of the network. This leaves 256 - 3 = 253 available IP
addresses for the example given.

User’s Manual 97



C.2.2 How IP Addresses are Used

The actual hardware connection via an Ethernet uses Ethernet adapter addresses (also
called MAC addresses). These are 48-bit addresses and are unique for every Ethernet
adapter manufactured. In order to send a packet to another computer, given the IP address
of the other computer, it is first determined if the packet needs to be sent directly to the
other computer or to the gateway. In either case, there is an IP address on the local net-
work to which the packet must be sent. A table is maintained to allow the protocol driver
to determine the MAC address corresponding to a particular IP address. If the table is
empty, the MAC address is determined by sending an Ethernet broadcast packet to all
devices on the local network asking the device with the desired IP address to answer with
its MAC address. In this way, the table entry can be filled in. If no device answers, then
the device is nonexistent or inoperative, and the packet cannot be sent.

IP addresses are arbitrary and can be allocated as desired provided that they don’t conflict
with other IP addresses. However, if they are to be used with the Internet, then they must
be numbers that are assigned to your connection by proper authorities, generally by dele-
gation via your service provider.

Each RCM3400 RabbitCore module has its own unique MAC address, which consists of
the prefix 0090C2 followed by a code that is unique to each RCM3400 module. For exam-
ple, a MAC address might be 0090C2C002C0.

TIP: You can always obtain the MAC address on your board by running the sample pro-
gram DISPLAY MAC.C from the SAMPLES\TCPIP folder.
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C.2.3 Dynamically Assigned Internet Addresses

In many instances, there are no fixed IP addresses. This is the case when, for example, you
are assigned an IP address dynamically by your dial-up Internet service provider (ISP) or
when you have a device that provides your IP addresses using the Dynamic Host Configu-
ration Protocol (DHCP). The RCM3400 modules can use such IP addresses to send and
receive packets on the Internet, but you must take into account that this IP address may
only be valid for the duration of the call or for a period of time, and could be a private IP
address that is not directly accessible to others on the Internet. These private address can
be used to perform some Internet tasks such as sending e-mail or browsing the Web, but
usually cannot be used to participate in conversations that originate elsewhere on the
Internet. If you want to find out this dynamically assigned IP address, under Windows 98
you can run the winipcfg program while you are connected and look at the interface
used to connect to the Internet.

Many networks use private IP addresses that are assigned using DHCP. When your com-
puter comes up, and periodically after that, it requests its networking information from a
DHCP server. The DHCP server may try to give you the same address each time, but a
fixed IP address is usually not guaranteed.

If you are not concerned about accessing the RCM3400 from the Internet, you can place
the RCM3400 on the internal network using a private address assigned either statically or
through DHCP.
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C.3 Placing Your Device on the Network

In many corporate settings, users are isolated from the Internet by a firewall and/or a
proxy server. These devices attempt to secure the company from unauthorized network
traffic, and usually work by disallowing traffic that did not originate from inside the net-
work. If you want users on the Internet to communicate with your RCM3400, you have
several options. You can either place the RCM3400 directly on the Internet with a real
Internet address or place it behind the firewall. If you place the RCM3400 behind the fire-
wall, you need to configure the firewall to translate and forward packets from the Internet
to the RCM3400.
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C.4 Running TCP/IP Sample Programs

We have provided a number of sample programs demonstrating various uses of TCP/IP for

networking embedded systems. These programs require you to connect your PC and the
RCM3400 board together on the same network. This network can be a local private net-

work (preferred for initial experimentation and debugging), or a connection via the Internet.

RCM3400
System

User’s PC

Ethernet

crossover

cable

Direct Connection

(network of 2 computers)

RCM3400

System

Ethernet
cables

Direct Connection Using a Hub

=

L1

NjEfnE

Hub

.

To additional
network
elements
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C.4.1 How to Set IP Addresses in the Sample Programs

With the introduction of Dynamic C 7.30 we have taken steps to make it easier to run
many of our sample programs. You will see a TcPCONFIG macro. This macro tells
Dynamic C to select your configuration from a list of default configurations. You will
have three choices when you encounter a sample program with the TCPCONFIG macro.

1. You can replace the TcpcoNFIG macro with individual MY IP ADDRESS,
MY NETMASK, MY GATEWAY, and MY NAMESERVER mMacros in each program.

2. You can leave TcPCONFIG at the usual default of 1, which will set the IP configurations
t010.10.6.100, the netmask to 255.255.255. 0, and the nameserver and gateway
t010.10.6.1. If youwould like to change the default values, for example, to use an IP
addressof 10.1.1.2 for the RCM3400 board, and 10.1. 1. 1 for your PC, you can edit
the values in the section that directly follows the “General Configuration” comment in
the TcP_coNFIG.LIB library. You will find this library in the LIB\TCPIP directory.

3. You can create a CUSTOM CONFIG.LIB library and use a TCPCONFIG value greater
than 100. Instructions for doing this are at the beginning of the TcP CONFIG.LIB
library in the LIB\TCPIP directory.

There are some other “standard” configurations for TcpcoNF1G that let you select differ-
ent features such as DHCP. Their values are documented at the top of the
TCP_CONFIG.LIB library in the LIB\TCPIP directory. More information is available in
the Dynamic C TCP/IP User’s Manual.

IP Addresses Before Dynamic C 7.30

Most of the sample programs use macros to define the IP address assigned to the board and
the IP address of the gateway, if there is a gateway. Instead of the TCPCONFIG macro, you
will see aMy IP ADDRESS macro and other macros.

#define MY IP ADDRESS "10.10.6.170"

#define MY NETMASK "255.255.255.0"

#define MY GATEWAY "10.10.6.1"
#define MY NAMESERVER "10.10.6.1"

In order to do a direct connection, the following IP addresses can be used for the RCM3400:

#define MY IP ADDRESS "10.1.1.2"

#define MY NETMASK "255.255.255.0"

// #define MY GATEWAY "10.10.6.1"

// #define MY NAMESERVER "10.10.6.1"
In this case, the gateway and nameserver are not used, and are commented out. The IP
address of the board is defined to be 10.1.1.2. The IP address of your PC can be defined

as10.1.1.1.
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C.4.2 How to Set Up your Computer’s IP Address for Direct Connect

When your computer is connected directly to the RCM3400 Prototyping Board via an
Ethernet connection, you need to assign an IP address to your computer. To assign the PC
the address 10.10.6.101 with the netmask 255.255.255. 0, do the following.

Click on Start > Settings > Control Panel to bring up the Control Panel, and then
double-click the Network icon. Depending on which version of Windows you are using,
look for the TCP/IP Protocol/Network > Dial-Up Connections/Network line or tab.
Double-click on this line or select Properties or Local Area Connection > Properties
to bring up the TCP/IP properties dialog box. You can edit the IP address and the subnet
mask directly. (Disable “obtain an IP address automatically”.) You may want to write
down the existing values in case you have to restore them later. It is not necessary to edit
the gateway address since the gateway is not used with direct connect.

RCM3400
IP 10.10.6.101 System
Netmask
255.255.255.0 /\/
-
User’s PC /
Ethernet
crossover
cable

Direct Connection PC to RCM3400 System
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C.5 Run the PINGME.C Sample Program

Connect the crossover cable from your computer’s Ethernet port to the RJ-45 Ethernet
connector on the RCM3400 Prototyping Board. Open this sample program from the
saMPLES\TCPIP\ICMP folder, compile the program, and start it running under Dynamic C.
When the program starts running, the green LNK light on the RCM3400 Prototyping
Board should be on to indicate an Ethernet connection is made. (Note: If the LNK light
does not light, you may not have a crossover cable, or if you are using a hub perhaps the
power is off on the hub.)

The next step is to ping the board from your PC. This can be done by bringing up the MS-
DOS window and running the pingme program:

ping 10.10.6.100

or by Start > Run

and typing the entry

ping 10.10.6.100

Notice that the red ACT light flashes on the RCM3400 Prototyping Board while the ping
is taking place, and indicates the transfer of data. The ping routine will ping the board four
times and write a summary message on the screen describing the operation.

C.6 Running Additional Sample Programs With Direct Connect

The sample programs discussed here are in the Dynamic C SAMPLES\RCM3400\TCPIP\
folder.

e BROWSELED.C—This program demonstrates a basic controller running a Web page.
Two “LEDs” are created on the Web page, and two buttons on the Prototyping Board
then toggle them. Users can change the status of the lights from the Web browser. The
LEDs on the Prototyping Board match the ones on the Web page. As long as you have
not modified the TcPCONFIG 1 macro in the sample program, enter the following
server address in your Web browser to bring up the Web page served by the sample pro-
gram.

http://10.10.6.100
Otherwise use the TCP/IP settings you entered in the TcP_CONFIG.LIB library.

e MBOXDEMO.C—Implements a Web server that allows e-mail messages to be entered
and then shown on the LCD/keypad module.

e PINGLED.C—This program demonstrates ICMP by pinging a remote host. It will flash
LEDs DS1 and DS2 on the Prototyping Board when a ping is sent and received.

e sMTP.C—This program allows you to send an E-mail when a switch on the Prototyp-
ing Board is pressed. Follow the instructions included with the sample program.
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C.7 Where Do | Go From Here?

NOTE: If you purchased your RCM3400 through a distributor or through a Rabbit Semi-
conductor partner, contact the distributor or partner first for technical support.

If there are any problems at this point:
e Use the Dynamic C Help menu to get further assistance with Dynamic C.

e Check the Rabbit Semiconductor Technical Bulletin Board at
www.rabbit.com/support/bb/.

e Use the Technical Support e-mail form at www.rabbit.com/support/.
If the sample programs ran fine, you are now ready to go on.
Additional sample programs are described in the Dynamic C TCP/IP User’s Manual.

Please refer to the Dynamic C TCP/IP User’s Manual to develop your own applications.
An Introduction to TCP/IP provides background information on TCP/IP, and is available
on the CD and on our \Web site.

User’s Manual 105


http://www.rabbit.com/
http://www.rabbit.com/support/bb/index.html
http://www.rabbit.com/support/questionSubmit.shtml

106 RabbitCore RCM3400



APPENDIX D. LCD/KEYPAD MODULE

An optional LCD/keypad is available for the Prototyping Board.
Appendix D describes the LCD/keypad and provides the soft-
ware function calls to make full use of the LCD/keypad.

D.1 Specifications

Two optional LCD/keypad modules—with or without a panel-mounted NEMA 4 water-
resistant bezel—are available for use with the RCM3400 Prototyping Board. They are
shown in Figure D-1.

LCD/Keypad Modules

0O @00@@000 eo0oc0o0o0o0

B0

B0

Figure D-1. LCD/Keypad Module Versions

Only the version without the bezel can mount directly on the Prototyping Board; if you
have the version with a bezel, you will have to remove the bezel to be able to mount the
LCD/keypad module on the Prototyping Board. Either version of the LCD/keypad module
can be installed at a remote location up to 60 cm (24™) away. Contact your sales representa-
tive or your authorized Rabbit Semiconductor distributor for further assistance in purchasing
an LCD/keypad module.
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Mounting hardware and a 60 cm (24") extension cable are also available for the LCD/
keypad module through your sales representative or authorized distributor.

Table D-1 lists the electrical, mechanical, and environmental specifications for the LCD/
keypad module.

Table D-1. LCD/Keypad Specifications

Parameter Specification
RS
Bezel Size 4.50" x 3.60" x 0.30"

(114 mm x 91 mm % 7.6 mm)

Temperature Storage Ranges 40°C 1o 185°C
Humidity 5% to 95%, noncondensing
Power Consumption 1.5 W maximum”
Connections Connects to high-rise header sockets on the Prototyping Board
LCD Panel Size 122 x 32 graphic display
Keypad 7-key keypad
LEDs Seven user-programmable LEDs

* The backlight adds approximately 650 mW to the power consumption.

The LCD/keypad module has 0.1"

IDC headers at J1, J2, and J3 for L l.0.100
physical connection to other boards or 29
ribbon cables. Figure D-2 shows the
LCD/keypad module footprint. These P
values are relative to one of the T R
mounting holes. gs
NOTE: All measurements are in ¥ D S,
inches followed by millimeters G
enclosed in parentheses. All dimen- 52
sions have a manufacturing toler- g8e v
ance of £0.01" (0.25 mm). -3
0.200 |__,|.0.500,
(5.1) (12.7)
1.450
(36.8)
2.200
(55.9)

Figure D-2. Mother Board Footprint for
LCD/Keypad Module
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D.2 Contrast Adjustments for All Boards

Starting in 2005, LCD/keypad modules were factory-configured to optimize their contrast
based on the voltage of the system they would be used in. Be sure to select a KDU3V
LCD/keypad module for use with the RCM3400 Prototyping Board — these modules
operate at 3.3 V. You may adjust the contrast using the potentiometer at R2 as shown in
Figure D-3. LCD/keypad modules configured for 5 V may be used with the 3.3 V
RCM3400 Prototyping Board, but the backlight will be dim.

LCD/Keypad Module Jumper Configurations

L Pins Factory
Header Description Connected Default
28V 12 X
75 33V 34
5V nc.
Contrast

Adjustment [

om OmR OB

R13 R14

il
&

T or §06 8Ol

om OmR OB

on

o O

(0]
=0

Hd E

5o [}
Q8

Part No. 101-0541

DISPLAY
BOARD

O

Figure D-3. LCD/Keypad Module Voltage Settings

You can set the contrast on the LCD display of pre-2005 LCD/keypad modules by adjust-
ing the potentiometer at R2 or by setting the voltage for 3.3 V by connecting the jumper
across pins 3—4 on header J5 as shown in Figure D-3. Only one of these two options is
available on these LCD/keypad modules.

NOTE: Older LCD/keypad modules that do not have a header at J5 or a contrast adjust-
ment potentiometer at R2 are limited to operate only at 5 V, and will not work with the
RCM3400 Prototyping Board. The older LCD/keypad modules are no longer being sold.
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D.3 Keypad Labeling

The keypad may be labeled according to your needs. A template is provided in Figure D-4
to allow you to design your own keypad label insert.

(28)

Figure D-4. Keypad Template

To replace the keypad legend, remove the old legend and insert your new legend prepared
according to the template in Figure D-4. The keypad legend is located under the blue key-
pad matte, and is accessible from the left only as shown in Figure D-5.

Keypad label is located

under the blue keypad matte. O Q000000 O

<JoRvl»
B00

Figure D-5. Removing and Inserting Keypad Label

)

The sample program KEYBASIC.C in the 122x32 1x7 folder in SAMPLES\LCD KEYPAD
shows how to reconfigure the keypad for different applications.

110 RabbitCore RCM3400



D.4 Header Pinouts
Figure D-6 shows the pinouts for the LCD/keypad module.
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Figure D-6. LCD/Keypad Module Pinouts

D.4.1 1/0O Address Assignments

The LCD and keypad on the LCD/keypad module are addressed by the /CS strobe as
explained in Table D-2.

Table D-2. LCD/Keypad Module Address Assignment

Address Function
0xE000 Device select base address (/CS)
OXExx0-0xExx7 LCD control
OXExx8 LED enable
OxExx9 Not used
OXExxA 7-key keypad
OXExxB (bits 0-6) 7-LED driver
OxExxB (bit 7) LCD backlight on/off
OXExxC-ExxF Not used
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D.5 Mounting LCD/Keypad Module on the Prototyping Board

Install the LCD/keypad module on header sockets LCD1JA, LCD1JB, and LCD1JC of the
Prototyping Board as shown in Figure D-7. Be careful to align the pins over the headers,
and do not bend them as you press down to mate the LCD/keypad module with the Proto-

typing Board.

&
\I[V/A*

o By e 2 . ;ﬁ

)10.0.0.0.0.0.0.0.0.0.0.0.0.0.¢ DOO0O00

OO0000000000000000000 A
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0O0000000000000000000000DDL

000000000VO000000V00000VVV
oe: 00000000000000000000000Q0
m 0O000000000000000000000000
QO000Q0Q00Q00Q0Q0QQQ0Q0QO0!
16.6161010]0]6]0]6]6610101010]0]6]0]0.0101016.6]¢

Figure D-7. Install LCD/Keypad Module on Prototyping Board
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D.6 Bezel-Mount Installation

This section describes and illustrates how to bezel-mount the LCD/keypad module
designed for remote installation. Follow these steps for bezel-mount installation.

1. Cut mounting holes in the mounting panel in accordance with the recommended dimen-
sions in Figure D-8, then use the bezel faceplate to mount the LCD/keypad module

onto the panel.

0125 D, 4x
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// \
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wéﬁ ——————————— — S
. 0.230 Sf
(5.8) s
2.870 N
(72.9)
3.100
(78.8)

Figure D-8. Recommended Cutout Dimensions

2. Carefully “drop in” the LCD/keypad module with the bezel and gasket attached.
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3. Fasten the unit with the four 4-40 screws and washers included with the LCD/keypad
module. If your panel is thick, use a 4-40 screw that is approximately 3/16" (5 mm)
longer than the thickness of the panel.

/7 Bezel/Gasket

Om Om OEN ON ON Om Om
FCUEMD20D 200 200 200 2Eg
Bl

Figure D-9. LCD/Keypad Module Mounted in Panel (rear view)

Carefully tighten the screws until the gasket is compressed and the plastic bezel face-
plate is touching the panel.

Do not tighten each screw fully before moving on to the next screw. Apply only one or
two turns to each screw in sequence until all are tightened manually as far as they can
be so that the gasket is compressed and the plastic bezel faceplate is touching the panel.
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D.6.1 Connect the LCD/Keypad Module to Your Prototyping Board

The LCD/keypad module can be located as far as 2 ft. (60 cm) away from the RCM3400
Prototyping Board, and is connected via a ribbon cable as shown in Figure D-10.
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Figure D-10. Connecting LCD/Keypad Module to RCM3400 Prototyping Board

Note the locations and connections relative to pin 1 on both the RCM3400 Prototyping
Board and the LCD/keypad module.

Rabbit Semiconductor offers 2 ft. (60 cm) extension cables. Contact your authorized Rabbit
Semiconductor distributor or a sales representative for more information.
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D.7 Sample Programs

Sample programs illustrating the use of the LCD/keypad module with the Prototyping
Board are provided in the SAMPLES\RCM3400\LCD KEYPAD directory.

These sample programs use the auxiliary 1/0 bus on the Rabbit 3000 chip, and so the
#define PORTA AUX IO lineis already included in the sample programs.

Each sample program has comments that describe the purpose and function of the pro-
gram. Follow the instructions at the beginning of the sample program. To run a sample
program, open it with the File menu (if it is not still open), then compile and run it by
pressing F9. The RCM3400 must be connected to a PC using the programming cable as
described in Chapter 2, “Getting Started.”.

Complete information on Dynamic C is provided in the Dynamic C User’s Manual.

e KEYPADTOLED.C—This program demonstrates the use of the external 1/0 bus. The
program will light up an LED on the LCD/keypad module and will display a message
on the LCD when a key press is detected. The DS1 and DS2 LEDs on the Prototyping
Board will also light up.

e LCDKEYFUN.C—This program demonstrates how to draw primitive features from the
graphic library (lines, circles, polygons), and also demonstrates the keypad with the key
release option.

e SWITCHTOLED.C—This program demonstrates the use of the external 1/0 bus. The
program will light up an LED on the LCD/keypad module and will display a message
on the LCD when a switch press is detected. The DS1 and DS2 LEDs on the Prototyp-
ing Board will also light up.

Additional sample programs are available in the SAMPLES\LCD KEYPAD\122x32 1x7
subdirectory.
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D.8 LCD/Keypad Module Function Calls

When mounted on the Prototyping Board, the LCD/keypad module uses the auxiliary 1/0
bus on the Rabbit 3000 chip. Remember to add the line

#define PORTA AUX IO

to the beginning of any programs using the auxiliary 1/0 bus.
D.8.1 LCD/Keypad Module Initialization

The function used to initialize the LCD/keypad module can be found in the Dynamic C
LIB\DISPLAYS\LCD122KEY7 LIB library.

void dispInit();

Initializes the LCD/keypad module. The keypad is set up using keypadDef () or keyConfig () after
this function call.

RETURN VALUE
None.

D.8.2 LEDs

When power is applied to the LCD/keypad module for the first time, the red LED (DS1)
will come on, indicating that power is being applied to the LCD/keypad module. The red
LED is turned off when the brdInit function executes.

One function is available to control the LEDs, and can be found in the Dynamic C
LIB\DISPLAYS\LCD122KEY7 LIB library.

void displedOut (int led, int wvalue);

LED on/off control. This function will only work when the LCD/keypad module is installed on the
Prototyping Board.

PARAMETERS
led is the LED to control.
0=LED DS1
1=LED DS2
2 =LED DS3
3=LED DS4
4 =LED DS5
5= LED DS6
6 = LED DS7

value is the value used to control whether the LED is on or off (0 or 1).
0 = off
1=on

RETURN VALUE
None.

SEE ALSO
brdInit

User’s Manual 117



D.8.3 LCD Display

The functions used to control the LCD display are contained in the GrRaPHIC.LIB library
located in the Dynamic C LIB\DISPLAYS\GRAPHIC library folder. When x and y coordi-
nates on the display screen are specified, x can range from 0 to 121, and y can range from
0 to 31. These numbers represent pixels from the top left corner of the display.

void glInit(void) ;

Initializes the display devices, clears the screen.

RETURN VALUE
None.

SEE ALSO
glDispOnOFF, glBacklight, glSetContrast, glPlotDot, glBlock, glPlotDot,
glPlotPolygon, glPlotCircle, glHScroll, glVScroll, glXFontInit, glPrintf,
glPutChar, glSetBrushType, glBufflock, glBuffUnlock, glPlotLine

void glBackLight (int onOff) ;

Turns the display backlight on or off.
PARAMETER
onOf £ turns the backlight on or off

1—turn the backlight on
0—turn the backlight off

RETURN VALUE
None.

SEE ALSO
glInit, glDispOnoff, glSetContrast

void glDispOnOff (int onOff) ;

Sets the LCD screen on or off. Data will not be cleared from the screen.
PARAMETER
onOf f turns the LCD screen on or off

1—turn the LCD screen on
0—turn the LCD screen off

RETURN VALUE
None.

SEE ALSO
glInit, glSetContrast, glBackLight
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void glSetContrast (unsigned level) ;

Sets display contrast.

NOTE: This function is not used with the LCD/keypad module since the support circuits
are not available on the LCD/keypad module.

void glFillScreen(char pattern);

Fills the LCD display screen with a pattern.

PARAMETER
The screen will be set to all black if pattern is OXFF, all white if pattern is 0x00, and vertical stripes

for any other pattern.

RETURN VALUE
None.

SEE ALSO
glBlock, glBlankScreen, glPlotPolygon, glPlotCircle

void glBlankScreen (void) ;

Blanks the LCD display screen (sets LCD display screen to white).

RETURN VALUE
None.

SEE ALSO
glFillScreen, glBlock, glPlotPolygon, glPlotCircle

void glFillRegion(int left, int top, int width,
int height, char pattern);

Fills a rectangular block in the LCD buffer with the pattern specified. Any portion of the block that is
outside the LCD display area will be clipped.

PARAMETERS
left is the x coordinate of the top left corner of the block.
top is the y coordinate of the top left corner of the block.
width is the width of the block.
height is the height of the block.
pattern is the bit pattern to display (all black if pattern is OxFF, all white if pattern is 0x00, and
vertical stripes for any other pattern).

RETURN VALUE
None.

SEE ALSO
glFillScreen, glBlankScreen, glBlock, glBlankRegion
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void glFastFillRegion(int left, int top, int width,
int height, char pattern);

Fills a rectangular block in the LCD buffer with the pattern specified. The block left and width parame-
ters must be byte-aligned. Any portion of the block that is outside the LCD display area will be clipped.

PARAMETERS
left is the x coordinate of the top left corner of the block.
top is the y coordinate of the top left corner of the block.
width is the width of the block.
height is the height of the block.
pattern is the bit pattern to display (all black if pattern is OxFF, all white if pattern is 0x00, and
vertical stripes for any other pattern).

RETURN VALUE
None.

SEE ALSO
glFillScreen, glBlankScreen, glBlock, glBlankRegion

void glBlankRegion (int left, int top, int width,
int height) ;

Clears a region on the LCD display. The block left and width parameters must be byte-aligned. Any por-
tion of the block that is outside the LCD display area will be clipped.

PARAMETERS
left is the x coordinate of the top left corner of the block (x must be evenly divisible by 8).

top is the y coordinate of the top left corner of the block.
width is the width of the block (must be evenly divisible by 8).
height is the height of the block.

RETURN VALUE
None.

SEE ALSO
glFillScreen, glBlankScreen, glBlock
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void glBlock(int left, int top, int width,
int height) ;

Draws a rectangular block in the page buffer and on the LCD if the buffer is unlocked. Any portion of the
block that is outside the LCD display area will be clipped.

PARAMETERS
left is the x coordinate of the top left corner of the block.
top is the y coordinate of the top left corner of the block.
width is the width of the block.
height is the height of the block.

RETURN VALUE
None.

SEE ALSO
glFillScreen, glBlankScreen, glPlotPolygon, glPlotCircle

void glPlotVPolygon(int n, int *pFirstCoord) ;

Plots the outline of a polygon in the LCD page buffer, and on the LCD if the buffer is unlocked. Any
portion of the polygon that is outside the LCD display area will be clipped. If fewer than 3 vertices are
specified, the function will return without doing anything.

PARAMETERS
n is the number of vertices.
pFirstCoord is a pointer to array of vertex coordinates: x1,y1, x2,y2, x3,y3, .

RETURN VALUE
None.

SEE ALSO
glPlotPolygon, glFillPolygon, glFillVPolygon
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void glPlotPolygon(int n, int yl, int x1, int y2,
int x2, ...);

Plots the outline of a polygon in the LCD page buffer and on the LCD if the buffer is unlocked. Any
portion of the polygon that is outside the LCD display area will be clipped. If fewer than 3 vertices are
specified, the function will return without doing anything.

PARAMETERS
n is the number of vertices.
y1is the y coordinate of the first vertex.
x1 is the x coordinate of the first vertex.
y2 is the y coordinate of the second vertex.
x2 is the x coordinate of the second vertex.
. . . are the coordinates of additional vertices.

RETURN VALUE
None.

SEE ALSO
glPlotVPolygon, glFillPolygon, glFillVPolygon

void glFillVPolygon (int n, int *pFirstCoord) ;

Fills a polygon in the LCD page buffer and on the LCD screen if the buffer is unlocked. Any portion of
the polygon that is outside the LCD display area will be clipped. If fewer than 3 vertices are specified,
the function will return without doing anything.

PARAMETERS
n is the number of vertices.
pFirstCoord is a pointer to array of vertex coordinates: x1,y1, x2,y2, x3,y3, ...

RETURN VALUE
None.

SEE ALSO
glFillPolygon, glPlotPolygon, glPlotVPolygon
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void glFillPolygon(int n, int x1, int y1l, int x2,
int Y2 Y 4 e o o ) ;
Fills a polygon in the LCD page buffer and on the LCD if the buffer is unlocked. Any portion of the

polygon that is outside the LCD display area will be clipped. If fewer than 3 vertices are specified, the
function will return without doing anything.

PARAMETERS
n is the number of vertices.
x1 is the x coordinate of the first vertex.
y1is the y coordinate of the first vertex.
x2 is the x coordinate of the second vertex.
y2 is the y coordinate of the second vertex.
. .. are the coordinates of additional vertices.

RETURN VALUE
None.

SEE ALSO
glFillVPolygon, glPlotPolygon, glPlotVPolygon

void glPlotCircle(int xc, int yc, int rad);

Draws the outline of a circle in the LCD page buffer and on the LCD if the buffer is unlocked. Any por-
tion of the circle that is outside the LCD display area will be clipped.

PARAMETERS
xc is the x coordinate of the center of the circle.
ye is the y coordinate of the center of the circle.
rad is the radius of the center of the circle (in pixels).

RETURN VALUE
None.

SEE ALSO
glFillCircle, glPlotPolygon, glFillPolygon

void glFillCircle(int xc, int yc, int rad);

Draws a filled circle in the LCD page buffer and on the LCD if the buffer is unlocked. Any portion of the
circle that is outside the LCD display area will be clipped.

PARAMETERS
xc is the x coordinate of the center of the circle.

ye is the y coordinate of the center of the circle.
rad is the radius of the center of the circle (in pixels).

RETURN VALUE
None.

SEE ALSO
glPlotCircle, glPlotPolygon, glFillPolygon
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void glXFontInit (fontInfo *pInfo, char pixWidth,
char pixHeight, unsigned startChar,
unsigned endChar, unsigned long xmemBuffer) ;

Initializes the font descriptor structure, where the font is stored in xmem. Each font character's bitmap is
column major and byte-aligned.

PARAMETERS
pInfo is a pointer to the font descriptor to be initialized.
pixWidth is the width (in pixels) of each font item.
pixHeight is the height (in pixels) of each font item.
startChar is the value of the first printable character in the font character set.
endChar is the value of the last printable character in the font character set.

xmemBuf fer is the xmem pointer to a linear array of font bitmaps.

RETURN VALUE
None.

SEE ALSO
glPrinf

unsigned long glFontCharAddr (fontInfo *pInfo,
char letter);

Returns the xmem address of the character from the specified font set.

PARAMETERS
*pInfo is the xmem address of the bitmap font set.
letter isan ASCII character.

RETURN VALUE
xmem address of bitmap character font, column major and byte-aligned.

SEE ALSO
glPutFont, glPrintf
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void glPutFont (int x, int y, fontInfo *pInfo,
char code) ;

Puts an entry from the font table to the page buffer and on the LCD if the buffer is unlocked. Each font
character's bitmap is column major and byte-aligned. Any portion of the bitmap character that is outside
the LCD display area will be clipped.

PARAMETERS
x is the x coordinate (column) of the top left corner of the text.
y is the y coordinate (row) of the top left corner of the text.
pInfo is a pointer to the font descriptor.
code is the ASCII character to display.

RETURN VALUE
None.

SEE ALSO
glFontCharAddr, glPrintf

void glSetPfStep(int stepX, int stepY);

Setsthe glPrint£ () printing step direction. The x and y step directions are independent signed values.
The actual step increments depend on the height and width of the font being displayed, which are multi-
plied by the step values.

PARAMETERS
stepX isthe glPrintf x step value

stepY isthe glPrint£ y step value

RETURN VALUE
None.

SEE ALSO
Use glGetP£fStep () to examine the current x and y printing step direction.

int glGetPfStep(void) ;

Gets the current glPrint £ () printing step direction. Each step direction is independent of the other,
and is treated as an 8-bit signed value. The actual step increments depends on the height and width of the
font being displayed, which are multiplied by the step values.

RETURN VALUE
The x step is returned in the MSB, and the y step is returned in the LSB of the integer result.

SEE ALSO
Use glGetP£fStep () to control the x and y printing step direction.
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void glPutChar (char ch, char *ptr, int *cnt,
glPutCharInst *plInst)

Provides an interface between the STDIO string-handling functions and the graphic library. The
STDIO string-formatting function will call this function, one character at a time, until the entire format-
ted string has been parsed. Any portion of the bitmap character that is outside the LCD display area will
be clipped.

PARAMETERS
ch is the character to be displayed on the LCD.

*ptr is not used, but is a place holder for STDIO string functions.
*cnt is not used, is a place holder for STDIO string functions.
pInst is a pointer to the font descriptor.

RETURN VALUE
None.

SEE ALSO
glPrintf, glPutFont, doprnt

void glPrintf (int x, int y, fontInfo *pInfo,
char *fmt, ...);

Prints a formatted string (much like print£) on the LCD screen. Only the character codes that exist in
the font set are printed, all others are skipped. For example, \b', \t', \n' and '\r' (ASCII backspace, tab,
new line, and carriage return, respectively) will be printed if they exist in the font set, but will not have
any effect as control characters. Any portion of the bitmap character that is outside the LCD display area
will be clipped.

PARAMETERS
x is the x coordinate (column) of the upper left corner of the text.

y is the y coordinate (row) of the upper left corner of the text.
pInfo is a pointer to the font descriptor.

*£mt is a formatted string.

. . . are formatted string conversion parameter(s).

EXAMPLE
glprintf (0,0, &£fil2x16, "Test %d\n", count);

RETURN VALUE
None.

SEE ALSO
glXFontInit
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void glBufflock (void) ;

Increments LCD screen locking counter. Graphic calls are recorded in the LCD memory buffer and are
not transferred to the LCD if the counter is non-zero.

NOTE: glBuffLock() and glBuffUnlock () can be nested up to a level of 255, but be
sure to balance the calls. It is not a requirement to use these procedures, but a set of
glBuffLock () and glBuffUnlock () bracketing a set of related graphic calls speeds
up the rendering significantly.

RETURN VALUE
None.

SEE ALSO
glBuffUnlock, glSwap

void glBuffUnlock(void) ;

Decrements the LCD screen locking counter. The contents of the LCD buffer are transferred to the LCD
if the counter goes to zero.

RETURN VALUE
None.

SEE ALSO
glBuffLock, glSwap

void glSwap (void) ;

Checks the LCD screen locking counter. The contents of the LCD buffer are transferred to the LCD if the
counter is zero.

RETURN VALUE
None.

SEE ALSO

glBuffUnlock, glBufflLock, glSwapData (located in the library specifically for the LCD
that you are using)

void glSetBrushType (int type);

Sets the drawing method (or color) of pixels drawn by subsequent graphic calls.
PARAMETER
type value can be one of the following macros.

PIXBLACK draws black pixels (turns pixel on).
PIXWHITE draws white pixels (turns pixel off).
PIXXOR draws old pixel XOR'ed with the new pixel.
RETURN VALUE
None.

SEE ALSO
glGetBrushType

User’s Manual 127



int glGetBrushType(void) ;
Gets the current method (or color) of pixels drawn by subsequent graphic calls.

RETURN VALUE
The current brush type.

SEE ALSO
glSetBrushType

void glXGetBitmap (int x, int y, int bmWidth,
int bmHeight, unsigned long xBm) ;

Gets a bitmap from the LCD page buffer and stores it in xmem RAM. This function automatically calls
glXGetFastmap if the left edge of the bitmap is byte-aligned and the left edge and width are each
evenly divisible by 8.
This function call is intended for use only when a graphic engine is used to interface with the LCD/keypad
module.
PARAMETERS
x is the x coordinate in pixels of the top left corner of the bitmap (x must be evenly divisible by 8).
y is the y coordinate in pixels of the top left corner of the bitmap.
bmwWidth is the width in pixels of the bitmap (must be evenly divisible by 8).
bmHeight is the height in pixels of the bitmap.
xBm is the xmem RAM storage address of the bitmap.

RETURN VALUE
None.

void glXGetFastmap(int left, int top, int width,
int height, unsigned long xmemptr) ;

Draws bitmap in the specified space. The data for the bitmap are stored in xmem. This function is similar
to glXPutBitmap, except that it's faster. The bitmap must be byte-aligned. Any portion of a bitmap
image or character that is outside the LCD display area will be clipped.
This function call is intended for use only when a graphic engine is used to interface with the LCD/keypad
module.
PARAMETERS
left is the x coordinate of the top left corner of the bitmap (x must be evenly divisible by 8).
top is the y coordinate in pixels of the top left corner of the bitmap.
width is the width of the bitmap (must be evenly divisible by 8).
height is the height of the bitmap.
xmemptr is the xmem RAM storage address of the bitmap.

RETURN VALUE
None.

SEE ALSO
glXPutBitmap, glPrintf
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void glPlotDot (int x, int y);

Draws a single pixel in the LCD buffer, and on the LCD if the buffer is unlocked. If the coordinates are
outside the LCD display area, the dot will not be plotted.

PARAMETERS
x is the x coordinate of the dot.
y is the y coordinate of the dot.

RETURN VALUE
None.

SEE ALSO
glPlotline, glPlotPolygon, glPlotCircle

void glPlotLine(int x0, int y0, int x1, int y1l);

Draws a line in the LCD buffer, and on the LCD if the buffer is unlocked. Any portion of the line that is
beyond the LCD display area will be clipped.

PARAMETERS
x0 is the x coordinate of one endpoint of the line.
y0 is the y coordinate of one endpoint of the line.
x1 is the x coordinate of the other endpoint of the line.
y1 is the y coordinate of the other endpoint of the line.

RETURN VALUE
None.

SEE ALSO
glPlotDot, glPlotPolygon, glPlotCircle

void glLeftl (int left, int top, int cols, int rows);

Scrolls byte-aligned window left one pixel, right column is filled by current pixel type (color).
PARAMETERS

left is the top left corner of bitmap, must be evenly divisible by 8, otherwise truncates.

top is the top left corner of the bitmap.

cols is the number of columns in the window, must be evenly divisible by 8, otherwise truncates.

rows is the number of rows in the window.

RETURN VALUE
None.

SEE ALSO
glHScroll, glRightl
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void glRightl (int left, int top, int cols, int rows);

Scrolls byte-aligned window right one pixel, left column is filled by current pixel type (color).

PARAMETERS
left is the top left corner of bitmap, must be evenly divisible by 8, otherwise truncates.

top is the top left corner of the bitmap.
cols is the number of columns in the window, must be evenly divisible by 8, otherwise truncates.

rows is the number of rows in the window.

RETURN VALUE
None.

SEE ALSO
glHScroll, glLeftl

void glUpl(int left, int top, int cols, int rows);

Scrolls byte-aligned window up one pixel, bottom column is filled by current pixel type (color).

PARAMETERS
left is the top left corner of bitmap, must be evenly divisible by 8, otherwise truncates.

top is the top left corner of the bitmap.
cols is the number of columns in the window, must be evenly divisible by 8, otherwise truncates.

rows is the number of rows in the window.

RETURN VALUE
None.

SEE ALSO
glvScroll, glDownl

void glDownl (int left, int top, int cols, int rows);

Scrolls byte-aligned window down one pixel, top column is filled by current pixel type (color).

PARAMETERS
left is the top left corner of bitmap, must be evenly divisible by 8, otherwise truncates.
top is the top left corner of the bitmap.
cols is the number of columns in the window, must be evenly divisible by 8, otherwise truncates.
rows is the number of rows in the window.

RETURN VALUE
None.

SEE ALSO
glvScroll, glUpl
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void glHScroll (int left, int top, int cols,
int rows, int nPix);

Scrolls right or left, within the defined window by x number of pixels. The opposite edge of the scrolled
window will be filled in with white pixels. The window must be byte-aligned.

Parameters will be verified for the following:

1. The Left and cols parameters will be verified that they are evenly divisible by 8. If not, they will
be truncated to a value that is a multiple of 8.

2. Parameters will be checked to verify that the scrolling area is valid. The minimum scrolling area is
a width of 8 pixels and a height of one row.
PARAMETERS
left is the top left corner of bitmap, must be evenly divisible by 8.
top is the top left corner of the bitmap.
cols is the number of columns in the window, must be evenly divisible by 8.
rows is the number of rows in the window.
nPix is the number of pixels to scroll within the defined window (a negative value will produce a scroll
to the left).

RETURN VALUE
None.

SEE ALSO
glvScroll
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void glVScroll (int left, int top, int cols,
int rows, int nPix);

Scrolls up or down, within the defined window by x number of pixels. The opposite edge of the scrolled
window will be filled in with white pixels. The window must be byte-aligned.

Parameters will be verified for the following:

1. The Left and cols parameters will be verified that they are evenly divisible by 8. If not, they will
be truncated to a value that is a multiple of 8.

2. Parameters will be checked to verify that the scrolling area is valid. The minimum scrolling area is
a width of 8 pixels and a height of one row.
PARAMETERS
left is the top left corner of bitmap, must be evenly divisible by 8.
top is the top left corner of the bitmap.
cols is the number of columns in the window, must be evenly divisible by 8.
rows is the number of rows in the window.
nPix is the number of pixels to scroll within the defined window (a negative value will produce a scroll
up).
RETURN VALUE
None.

SEE ALSO
glHScroll

void glXPutBitmap (int left, int top, int width,
int height, unsigned long bitmap) ;

Draws bitmap in the specified space. The data for the bitmap are stored in xmem. This function calls

glXPutFastmap automatically if the bitmap is byte-aligned (the left edge and the width are each

evenly divisible by 8).

Any portion of a bitmap image or character that is outside the LCD display area will be clipped.
PARAMETERS

left is the top left corner of the bitmap.

top is the top left corner of the bitmap.

width is the width of the bitmap.

height is the height of the bitmap.

bitmap is the address of the bitmap in xmem.

RETURN VALUE
None.

SEE ALSO
glXPutFastmap, glPrintf
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void glXPutFastmap(int left, int top, int width,
int height, unsigned long bitmap);

Draws bitmap in the specified space. The data for the bitmap are stored in xmem. This function is like
glXPutBitmap, except that it is faster. The restriction is that the bitmap must be byte-aligned.

Any portion of a bitmap image or character that is outside the LCD display area will be clipped.
PARAMETERS

left is the top left corner of the bitmap, must be evenly divisible by 8, otherwise truncates.

top is the top left corner of the bitmap.

width is the width of the bitmap, must be evenly divisible by 8, otherwise truncates.

height is the height of the bitmap.

bitmap is the address of the bitmap in xmem.

RETURN VALUE
None.

SEE ALSO
glXPutBitmap, glPrintf

int TextWindowFrame (windowFrame *window,
fontInfo *pFont, int x, int y, int winWidth,
int winHeight)

Defines a text-only display window. This function provides a way to display characters within the text
window using only character row and column coordinates. The text window feature provides end-of-line
wrapping and clipping after the character in the last column and row is displayed.

NOTE: Execute the TextWwindowFrame function before other Text. .. functions.
PARAMETERS
window is a pointer to the window frame descriptor.
pFont is a pointer to the font descriptor.
x is the x coordinate of the top left corner of the text window frame.
y is the y coordinate of the top left corner of the text window frame.
winWidth is the width of the text window frame.
winHeight is the height of the text window frame.
RETURN VALUE
0—window frame was successfully created.
-1—x coordinate + width has exceeded the display boundary.

-2—y coordinate + height has exceeded the display boundary.
-3—Invalid winHeight and/or winWidth parameter value.
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void TextBorderInit (windowFrame *wPtr, int border,
char *title);

This function initializes the window frame structure with the border and title information.

NOTE: Execute the TextWwindowFrame function before using this function.

PARAMETERS
wPtr iS a pointer to the window frame descriptor.

border is the border style:
SINGLE LINE—The function will draw a single-line border around the text window.
DOUBLE LINE—The function will draw a double-line border around the text window.

title is a pointer to the title information:
If a NULL string is detected, then no title is written to the text menu.
If a string is detected, then it will be written center-aligned to the top of the text menu box.

RETURN VALUE
None.

SEE ALSO
TextBorder, TextGotoXY, TextPutChar, TextWindowFrame, TextCursorLocation

void TextBorder (windowFrame *wPtr) ;

This function displays the border for a given window frame. This function will automatically adjust the
text window parameters to accommodate the space taken by the text border. This adjustment will only
occur once after the TextBorderInit function executes.

NOTE: Execute the TextWwindowFrame function before using this function.

PARAMETERS
wPtr is a pointer to the window frame descriptor.

RETURN VALUE
None.

SEE ALSO

TextBorderInit, TextGotoXY, TextPutChar, TextWindowFrame,
TextCursorLocation
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void TextGotoXY (windowFrame *window, int col,
int row) ;

Sets the cursor location to display the next character. The display location is based on the height and

width of the character to be displayed.
NOTE: Execute the TextWwindowFrame function before using this function.

PARAMETERS
window is a pointer to a font descriptor.

col is a character column location.
row is a character row location.

RETURN VALUE
None.

SEE ALSO
TextPutChar, TextPrintf, TextWindowFrame

void TextCursorLocation (windowFrame *window,
int *col, int *row);

Gets the current cursor location that was set by a Graphic Text. . . function.
NOTE: Execute the TextwindowFrame function before using this function.
PARAMETERS
window is a pointer to a font descriptor.
col is a pointer to cursor column variable.
row iS a pointer to cursor row variable.

RETURN VALUE
Lower word = Cursor Row location
Upper word = Cursor Column location

SEE ALSO
TextGotoXY, TextPrintf, TextWindowFrame, TextCursorLocation
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void TextPutChar (struct windowFrame *window, char ch);

Displays a character on the display where the cursor is currently pointing. Once a character is displayed,
the cursor will be incremented to the next character position. If any portion of a bitmap character is out-
side the LCD display area, the character will not be displayed.

NOTE: Execute the TextwindowFrame function before using this function.

PARAMETERS
*window is a pointer to a font descriptor.

ch is a character to be displayed on the LCD.

RETURN VALUE
None.

SEE ALSO
TextGotoXY, TextPrintf, TextWindowFrame, TextCursorLocation

void TextPrintf (struct windowFrame *window,
char *fmt, ...);

Prints a formatted string (much like print£) on the LCD screen. Only printable characters in the font
set are printed; escape sequences \r' and \n' are also recognized. All other escape sequences will be
skipped over; for example, "\b' and \'t" will cause nothing to be displayed.

The text window feature provides end-of-line wrapping and clipping after the character in the last col-
umn and row is displayed. The cursor then remains at the end of the string.
NOTE: Execute the TextwindowFrame function before using this function.
PARAMETERS
window is a pointer to a font descriptor.
*£mt is a formatted string.

. . . are formatted string conversion parameter(s).

EXAMPLE
TextPrintf (&TextWindow, "Test %d\n", count);

RETURN VALUE
None.

SEE ALSO
TextGotoXY, TextPutChar, TextWindowFrame, TextCursorLocation
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int TextMaxChars (windowFrame *wPtr) ;

This function returns the maximum number of characters that can be displayed within the text window.

NOTE: Execute the TextwindowFrame function before using this function.

PARAMETERS
wPtr is a pointer to the window frame descriptor.

RETURN VALUE
The maximum number of characters that can be displayed within the text window.

SEE ALSO

TextGotoXY, TextPrintf, TextWindowFrame, TextCursorLocation
void TextWinClear (windowFrame *wPtr) ;

This functions clears the entire area within the specified text window.

NOTE: Execute the TextwindowFrame function before using this function.

PARAMETERS
wPtr is a pointer to the window frame descriptor.

RETURN VALUE
None.

SEE ALSO

TextGotoXY, TextPrintf, TextWindowFrame, TextCursorLocation
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D.8.4 Keypad

The functions used to control the keypad are contained in the Dynamic C LIB\KEY -
PADS\KEYPAD7 .LIB library.

void keyInit (void);

Initializes keypad process

RETURN VALUE
None.

SEE ALSO
brdInit

void keyConfig(char cRaw, char cPress,
char cRelease, char cCntHold, char cSpdLo,
char cCntLo, char cSpdHi) ;

Assigns each key with key press and release codes, and hold and repeat ticks for auto repeat and
debouncing.

PARAMETERS
cRaw is a raw key code index.

1 x 7 keypad matrix with raw key code index assignments (in brackets):

[0] [1] (2] (3]
[4] [5] (6]

User Keypad Interface
cPress is a key press code

An 8-bit value is returned when a key is pressed.
0 = Unused.

See keypadDef () for default press codes.
cRelease is a key release code.

An 8-bit value is returned when a key is pressed.
0 = Unused.

cCntHold is a hold tick, which is approximately one debounce period or 5 ps.

How long to hold before repeating.
0 = No Repeat.

cSpdLo is a low-speed repeat tick, which is approximately one debounce period or 5 ps.

How many times to repeat.
0 = None.

cCntLo is a low-speed hold tick, which is approximately one debounce period or 5 ps.

How long to hold before going to high-speed repeat.
0 = Slow Only.
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cSpdHi is a high-speed repeat tick, which is approximately one debounce period or 5 ps.

How many times to repeat after low speed repeat.
0 = None.

RETURN VALUE
None.

SEE ALSO
keyProcess, keyGet, keypadDef

Scans and processes keypad data for key assignment, debouncing, press and release, and repeat.

NOTE: This function is also able to process an 8 x 8 matrix keypad.

RETURN VALUE
None

SEE ALSO
keyConfig, keyGet, keypadDef

Get next keypress

RETURN VALUE
The next keypress, or 0 if none

SEE ALSO
keyConfig, keyProcess, keypadDef

Pushes the value of cKey to the top of the input queue, which is 16 bytes deep.

PARAMETER
cKey

RETURN VALUE
None.

SEE ALSO
keyGet
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void keypadbDef () ;

Configures the physical layout of the keypad with the desired ASCII return key codes.

Example: Do the following for the above physical vs. ASCII return key codes.

Keypad physical mapping 1 x 7

0 4 1 5 2 6 3
(L] (U] [D] [R1]
[-] [+] [E]
where

'L represents Left Scroll
'U' represents Up Scroll

‘D' represents Down Scroll

'R’ represents Right Scroll
'~ represents Page Down
'+' represents Page Up

'E' represents the ENTER key

keyConfig
keyConfig
keyConfig
keyConfig
keyConfig
keyConfig
keyConfig

~ e~~~ o~~~

3,'R',0,
6,'E',0,
2,'p',0,
4,'-',0,
i,'u',o0,
5,'+',0,
0,'L',o0,

0,
0,
0,
0,
0,
0,
0,

o,
o,
0,
0,
0,
0,
0,

0,
0,
0,
0,
0,
0,
0,

Characters are returned upon keypress with no repeat.

RETURN VALUE
None.

SEE ALSO

keyConfig,

keyGet, keyProcess

void keyScan (char *pcKeys);

Writes "1" to each row and reads the value. The position of a keypress is indicated by a zero value in a bit
position.

PARAMETER
pcKeys is a pointer to the address of the value read.

RETURN VALUE
None.

SEE ALSO

keyConfig,

keyGet, keypadDef,

keyProcess
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APPENDIX E. POWER SUPPLY

Appendix D provides information on the current requirements
of the RCM3400, and includes some background on the chip
select circuit used in power management.

E.1 Power Supplies

The RCM3400 requires a regulated 2.8 VV — 3.45 V DC power source. The RabbitCore
design presumes that the voltage regulator is on the user board, and that the power is made
available to the RCM3400 board through header J1.

An RCM3400 with no loading at the outputs operating at 29.4 MHz typically draws 97 mA.
E.1.1 Battery-Backup Circuits

The RCM3400 does not have a battery, but there is provision for a customer-supplied bat-
tery to back up the data SRAM and keep the internal Rabbit 3000 real-time clock running.

Header J2, shown in Figure E-1, allows access to the external battery. This header makes
it possible to connect an external 3 V power supply. This allows the SRAM and the inter-
nal Rabbit 3000 real-time clock to retain data with the RCM3400 powered down.

J2

GND 1 2

o o External
Battery

33 34 VBAT_EXT
o O — |~ 1

Figure E-1. External Battery Connections
at Header J5

A lithium battery with a nominal voltage of 3 VV and a minimum capacity of 165 mA-h is
recommended. A lithium battery is strongly recommended because of its nearly constant
nominal voltage over most of its life.
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The drain on the battery by the RCM3400 is typically 7.5 pA when no other power is sup-
plied. If a 165 mA-h battery is used, the battery can last about 2.5 years:

165 mA-h

75 uA = 2.5 years.

The actual life in your application will depend on the current drawn by components not on
the RCM3400 and on the storage capacity of the battery. The RCM3400 does not drain the
battery while it is powered up normally.

Cycle the main power off/on on the RCM3400 after you install a backup battery for the
first time, and whenever you replace the battery. This step will minimize the current drawn
by the real-time clock oscillator circuit from the backup battery should the RCM3400
experience a loss of main power.

NOTE: Remember to cycle the main power off/on any time the RCM3400 is removed
from the Protoyping Board or motherboard since that is where the backup battery
would be located.

E.1.2 Reset Generator

The RCM3400 uses a reset generator to reset the Rabbit 3000 microprocessor when the volt-
age drops below the voltage necessary for reliable operation. The reset occurs between
2.85V and 3.00 V, typically 2.93 V. The RCM3400 has a reset output, pin 33 on header J1.
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SCHEMATICS

090-0157 RCM3400 Schematic

www.rabbit.com/documentation/schemat/090-0157.pdf

090-0162 Prototyping Board Schematic

www.rabbit.com/documentation/schemat/090-0162.pdf

090-0156 LCD/Keypad Module Schematic

www.rabbit.com/documentation/schemat/090-0156.pdf

090-0128 Programming Cable Schematic

www.rabbit.com/documentation/schemat/090-0128.pdf

You may use the URL information provided above to access the latest schematics directly.
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